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EKTRON, INC. SOFTWARE LICENSE AGREEMENT

** READ THIS BEFORE LOADING SOFTWARE**

YOUR RIGHT TO USE THE PRODUCT DELIVERED IS SUBJECT TO THE TERMS AND CONDITIONS SET OUT IN THIS LICENSE 
AGREEMENT. USING THIS PRODUCT SIGNIFIES YOUR AGREEMENT TO THESE TERMS. IF YOU DO NOT AGREE TO THIS SOFTWARE 
LICENSE AGREEMENT, DO NOT DOWNLOAD.

CUSTOMER should carefully read the following terms and conditions before using the software program(s) contained herein (the “Software”). 
Downloading and/or using the Software or copying the Software onto CUSTOMER’S computer hard drive indicates CUSTOMER’S acceptance of 
these terms and conditions. If CUSTOMER does not agree with the terms of this agreement, CUSTOMER should not download. 

Ektron, Inc. (“Ektron”) grants, and the CUSTOMER accepts, a nontransferable and nonexclusive License to use the Software on the following 
terms and conditions: 

        1.   Right to use: The Software is licensed for use only in delivered code form. Each copy of the Software is licensed for use only on a single 
URL. Each license is valid for the number of seats listed below (the “Basic Package”). Any use of the Software beyond the number of authorized 
seats contained in the Basic Package without paying additional license fees as provided herein shall cause this license to terminate. Should 
CUSTOMER wish to add seats beyond the seats licensed in the Basic Package, the CUSTOMER may add seats on a block basis at the then 
current price for additional seats (see product pages for current price). The Basic Packages are as follows: 

Ektron CMS100 — Licensed for ten seats (10 named users) per URL.

Ektron CMS200 — Licensed for ten seats (10 named users) per URL. 

Ektron CMS300 — Licensed for ten seats (10 named users) per URL. 

Ektron CMS400.NET — Licensed for ten seats (10 named users) per URL. 

Ektron Document Management Add-on — Licensed for ten seats (10 named users) per URL. 

Ektron eWebEditPro — Licensed for ten seats (10 named users) per URL. 

Ektron eWebEditPro+XML — Licensed for ten seats (10 named users) per URL.

For purposes of this section, the term “seat” shall mean an individual user provided access to the capabilities of the Software.

The CUSTOMER may not modify, alter, reverse engineer, disassemble, or decompile the Software. This software product is licensed, not sold.

        2.   Duration: This License shall continue so long as CUSTOMER uses the Software in compliance with this License. Should CUSTOMER 
breach any of its obligations hereunder, CUSTOMER agrees to return all copies of the Software and this License upon notification and demand by 
Ektron.

        3.   Copyright: The Software (including any images, “applets,” photographs, animations, video, audio, music and text incorporated into the 
Software) as well as any accompanying written materials (the “Documentation”) is owned by Ektron or its suppliers, is protected by United States 
copyright laws and international treaties, and contains confidential information and trade secrets. CUSTOMER agrees to protect the confidentiality 
of the Software and Documentation. CUSTOMER agrees that it will not provide a copy of this Software or Documentation nor divulge any 
proprietary information of Ektron to any person, other than its employees, without the prior consent of Ektron; CUSTOMER shall use its best efforts 
to see that any user of the Software licensed hereunder complies with this license.

        4.   Limited Warranty: Ektron warrants solely that the medium upon which the Software is delivered will be free from defects in material and 
workmanship under normal, proper and intended usage for a period of three (3) months from the date of receipt. Ektron does not warrant the use 
of the Software will be uninterrupted or error free, nor that program errors will be corrected. This limited warranty shall not apply to any error or 
failure resulting from (i) machine error, (ii) Customer's failure to follow operating instructions, (iii) negligence or accident, or (iv) modifications to the 
Software by any person or entity other than Company. In the event of a breach of warranty, Customer’s sole and exclusive remedy, is repair of all 
or any portion of the Software. If such remedy fails of its essential purpose, Customer’s sole remedy and Ektron’s maximum liability shall be a 
refund of the paid purchase price for the defective Products only. This limited warranty is only valid if Ektron receives written notice of breach of 
warranty within thirty days after the warranty period expires.

        5.   Limitation of Warranties and Liability: THE SOFTWARE AND DOCUMENTATION ARE SOLD “AS IS” AND WITHOUT ANY 
WARRANTIES AS TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF THE SOFTWARE. NO WARRANTY OF 
FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION 4, ALL WARRANTIES EXPRESS AND 
IMPLIED ARE HEREBY DISCLAIMED.

NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR GOODWILL, LOSS 
OF DATA OR USE OF DATA, INTERRUPTION OF BUSINESS NOR FOR ANY OTHER INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR ARISING OUT OF, OR IN ANY RELATED TO THIS AGREEMENT, HOWEVER, 
CAUSED, WHETHER FOR BREACH OF WARRANTY, BREACH OR REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE, 
EVEN IF COMPANY OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.



         6.   Miscellaneous: This License Agreement, the License granted hereunder, and the Software may not be assigned or in any way transferred 
without the prior written consent of Ektron. This Agreement and its performance and all claims arising from the relationship between the parties 
contemplated herein shall be governed by, construed and enforced in accordance with the laws of the State of New Hampshire without regard to 
conflict of laws principles thereof. The parties agree that any action brought in connection with this Agreement shall be maintained only in a court 
of competent subject matter jurisdiction located in the State of New Hampshire or in any court to which appeal therefrom may be taken. The parties 
hereby consent to the exclusive personal jurisdiction of such courts in the State of New Hampshire for all such purposes. The United Nations 
Convention on Contracts for the International Sale of Goods is specifically excluded from governing this License. If any provision of this License is 
to be held unenforceable, such holding will not affect the validity of the other provisions hereof. Failure of a party to enforce any provision of this 
Agreement shall not constitute or be construed as a waiver of such provision or of the right to enforce such provision. If you fail to comply with any 
term of this License, YOUR LICENSE IS AUTOMATICALLY TERMINATED. This License represents the entire understanding between the parties 
with respect to its subject matter.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT YOU UNDERSTAND THIS AGREEMENT, AND UNDERSTAND 
THAT BY CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR RUNNING THE SOFTWARE, OR BY PLACING OR 
COPYING THE SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE BOUND BY THIS AGREEMENT’S TERMS AND 
CONDITIONS. YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN SEPARATE AGREEMENTS BETWEEN EKTRON AND YOU, THIS 
AGREEMENT IS A COMPLETE AND EXCLUSIVE STATEMENT OF THE RIGHTS AND LIABILITIES OF THE PARTIES. 

Copyright 1999 - 2006 Ektron, Inc. All rights reserved.

LA10031, Revision 1.5

Trademarks

All terms in this manual that are known to be trademarks have been capitalized. Ektron, Inc. cannot attest to the accuracy of this information. Use 
of a term in this manual does not affect the validity of any trademark.

The following trademarks might appear in Ektron manuals: Active Directory®, ActiveX®, Authenticode®, BackOffice®, ClearType®, Developer 
Studio®, FrontPage®, IntelliSense®, JScript®, Microsoft ®, MS-DOS®, SharePoint ® Visual C++®, Visual C#®, Visual InterDev®, Visual J++®, 
Visual J#®, Visual Studio®, Visual Web Developer TM, Win32®, Win32s®, Windows®, Windows NT®, Windows Server TM, Windows Server 
System TM, Netscape®, Netscape Navigator®, Mozilla TM, Firefox TM
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System Requirements

The following components are required when developing or 
viewing an Ektron CMS400.NET based application.

• ”Server Requirements” on page 1

• ”PC Client Requirements” on page 2

• ”Apple Macintosh Client Requirements” on page 3

• ”Optional Software” on page 4

Server Requirements

Component Requirements

Recommended hardware 
configuration

• Intel® Pentium Hyper-Threaded or Intel® XeonTM 
Processor (with 800MHz Bus)

• 1 GB RAM or higher

• RAID array for hard drives

Web server operating system Microsoft ® Windows® 2003 Server recommended
Microsoft ® Windows® 2000, XP Professional 

Note: XP Home does not support IIS.
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PC Client Requirements

Web application server • Microsoft .NET ™ Framework 2.0 (required)

Note: If your site uses the Document Management 
functionality, .NET 1.1 Framework must also be 
installed.

• Microsoft Active Server Pages

• Macromedia ColdFusion MX or higher

• PHP

• JSP

Web server Microsoft® Internet Information Server (IIS) 4.0 or 
higher

Database • SQL™ Server 2000 recommended (Enterprise or 
Standard version)

• Microsoft ® MSDE 2000

Component Requirements

Component Requirements

Operating system Any IBM-PC compatible system running Windows
(suggested minimum: Pentium 166 MHz or faster with 64MB of 
RAM)

Browsers for viewing All major browsers including:

• Microsoft ® Internet Explorer 3.0 through 6.0

• Netscape Navigator ® Version 3.0 through 7.2 

• Mozilla Firefox 1.0
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Apple Macintosh Client Requirements

Browsers for editing • Mozilla Firefox 1.0

• Microsoft® Internet Explorer 5.0 through 6.0

• Netscape ® 7.2

Note: If using Netscape, IE 5.0 through 6.0 must be installed.

Note: When using the Document Management System, you must 
use a browser that supports ActiveX.

Important: For issues when using Microsoft Windows Server 2003 as 
a client, see ”Using Microsoft Windows Server 2003 as a Client 
(Web Folders Setup)” on page 70.

Hardware Any IBM-PC compatible system running Windows
(suggested minimum requirements: Pentium 166 MHz or faster with 
at least 64MB of RAM)

Web development tools Visual Studio .NET™2003

Component Requirements

Component Requirements

Operating system MAC OS X

Browsers for viewing All major browsers including:

• Microsoft ® Internet Explorer

• Netscape Navigator ® 

• Mozilla Firefox 1.0
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Optional Software

NOTE Ektron does not guarantee support of beta releases for new versions of any 
components listed above.

Browsers for editing • Apple Safari (Recommended)

• Mozilla Firefox 1.0

• Microsoft® Internet Explorer

• Netscape ® 

Important: If you use any browser other than Apple Safari, a text box 
appears in place of the WYSIWYG Integrated Macintosh Editor.

Hardware Apple Macintosh

Component Requirements

Component Requirements

Web development tools Visual Studio .NET™2003, Allaire HomeSite,.Macromedia/Allaire 
Coldfusion Studio, Macromedia Dreamweaver, Microsoft FrontPage, 
NotePad
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Preparing for Windows XP SP2

Microsoft Windows XP Service Pack 2 includes significant 
changes affecting Ektron CMS400.NET security, especially in 
regard to the installation of the eWebEditPro ActiveX control. The 
most significant change affects the eWebEditPro+XML editor in 
data design or data entry modes. To work around this change, 
configure Ektron CMS400.NET to allow pop-up windows for 
automatic download and installation.

More Information on Windows XP Service Pack 2
For more information on Windows XP Service Pack 2, visit the 
Microsoft site at www.microsoft.com/technet/prodtechnol/winxppro/
maintain/winxpsp2.mspx. One article on that site of particular 
interest to developers is "Changes to Functionality in Microsoft 
Windows XP Service Pack 2". Part 5 of that article, "Enhanced 
Browsing Security," details changes to Internet Explorer.

Disabling the Popup Blocker
Pop-up windows are used to initially install the editor in Internet 
Explorer (IE) and by other features, such as selecting an image 
and setting Section 508 Data Table properties. By default, 
Windows XP SP 2 blocks pop-up windows. For Ektron products to 
operate effectively, allow pop-up windows for web sites that host 
Ektron products.

Enabling Popup Windows
When a Web page in IE running on Windows XP Service Pack 2 
(XPSP2) attempts to open a pop-up, the Information Bar appears 
at the top of the page. The message on the Information Bar is Pop-
up blocked. To see this pop-up or additional options click 
here...

http://www.microsoft.com/technet/prodtechnol/winxppro/maintain/winxpsp2.mspx
http://www.microsoft.com/technet/prodtechnol/winxppro/maintain/winxpsp2.mspx
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To allow proper operation of the editor, enable pop-up windows for 
the Web site. To do so, click the Information Bar and select Always 
Allow Pop-ups from This Site.

For easier administration, add the Web site as a Trusted site. By 
default, this change disables the pop-up blocker.

Download and Installation with Windows XP SP2
The installation of the Ektron editor is only required the first time it 
is used and for every upgrade. The automatic installation 
supported in IE uses a pop-up to walk the user through the 
process. Therefore, the first step is to enable pop-up windows (see 
”Enabling Popup Windows” on page 5). An additional step to install 
the editor requires an extra mouse click by the user.
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If you are an administrator, you may want to configure client 
computers to avoid these extra steps. One simple way is to add the 
Web site that hosts Ektron products as a Trusted Site.

When installing the editor, the user should follow these steps.

1. When the Automatic Download and Installation page appears, 
click the Install button.

2. When the next window appears, the Information Bar displays 
this message:
To help protect your security, Internet Explorer stopped 
this site from installing an ActiveX control on your 
computer. Click here for options...

3. In place of the editor, the following message appears.
Click here to install the following ActiveX control: 
'eWebEditPro' from 'Ektron Inc'...

4. Click on either message and select Install ActiveX Control... 
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Upgrading Ektron CMS400.NET

The upgrade procedure copies Ektron CMS400.NET’s latest 
features to your Web server. Version 5.0 is installed to its own 
folder, CMS400v50. This means it can coexist on the same machine 
with previous versions -- the template directories are independent.

The Base Folder
The upgrade installs a base folder (C:\\Program 
Files\Ektron\CMS400v50), which provides a template for setting up 
Ektron CMS400.NET Web sites. The Site Setup utility uses the files 
in the base folder to create and upgrade Ektron CMS400.NET sites.

The base folder contains the following subfolders.

Subfolder Includes

Bin Required .NET assemblies for Ektron CMS400.NET  

cms400example A sample site that demonstrates the use of Ektron 
CMS400.NET

CMS400Min A minimal set of files site that is best for new 
integrations 

DMS400v11 Contains folders and files for the Document 
Management Functionality

Documentation Documentation. The site setup procedure copies this 
directory to the CMS400Workarea directory when setting 
up a site.

SiteSetup The sitesetup.exe utility and the needed database setup 
scripts
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NOTE The contents of this folder are later copied to a Web site folder, typically in the 
Web server’s web root. The sample provides a good way to learn how to work 
with an Ektron CMS400.NET site.
An alternative is the minimum database. Use this when you understand how to 
create a site and do not want to place extra, sample files on your server.

The Upgrade Procedure
Upgrading involves the following tasks. 

1. Install the new files to the new directories. See Also: ”Running 
the Installation and Setup Program” on page 43

2. Copy these folders to the site directory.

• bin

• workarea 

• cms400example

• Documentation

3. Update the web.config file with new settings.
4. Update your databases using the upgrade and language 

update utilities. See Also: ”Performing the Upgrade” on 
page 11

5. Create a new DSN for each database. See ”Creating a New 
DSN” on page 36

Utilities Utilities for 

• database upgrade

• database application strings update

• email encrypt password tool

• a setup Sharepoint Portal

• Asset Management Registration tool

Workarea Scripts used for the Workarea

Subfolder Includes
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6. If needed, modify the site to use the server controls. See Also: 
Ektron CMS400.NET Developer Manual section “Ektron 
CMS400.Net Server Controls” > “Making the Server Controls 
Available” > “Updating the Server Controls”.

This chapter walks you through the upgrade process.

Performing the Upgrade
There are three types of upgrades available for Ektron 
CMS400.NET. You can upgrade:

• CMS400 only

• Document Management Add-on only

• CMS400 + Document Management

When completing a CMS400 + Document Management upgrade, 
the upgrade first completes the CMS400 upgrade, then does the 
Document Management upgrade.

The following steps explain how to perform an Ektron 
CMS400.NET + Document Management Add-on upgrade. 

If you perform a CMS400 only upgrade, follow these steps until you 
get to the Document Management upgrade section. When the 
Upgrade Complete screen appears click finish. 

If you are performing a Document Management only upgrade 
complete steps 1-3 and skip down to ”Document Management 
Add-on Upgrade” on page 15.

1. Follow the steps of the installation procedure, ”Running the Installation and Setup Program” on page 43. 
These steps instruct you to install Ektron CMS400.NET  and restart your server. Return to step two when 
the Site Setup Selection appears.
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2. The Setup wizard 
appears. Choose 
Upgrade Site/
Reinstall.
(If this screen does 
not appear, launch it 
by following this path 
from the Windows 
Start menu:
Start > Programs > 
Ektron > CMS400 > 
Utilities > Site 
Setup)
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3. The Setup Type 
screen appears. 
Choose an option to 
upgrade.

• CMS400 - Choose 
this option if you are 
upgrading a 
CMS400 only instal-
lation.

• Document Manage-
ment Add-on - 
Choose this option if 
you are upgrading a 
standalone Docu-
ment Management 
server. Skip ahead to 
”Document Manage-
ment Add-on 
Upgrade” on 
page 15

• CMS400 + Docu-
ment Management 
Add-on - Choose 
this option if you are 
upgrading a server 
with both the 
CMS400 and Docu-
ment Management 
Add-on installed on 
it.

Note: If you have Ektron 
CMS400.NET  and the 
Document Management 
Add-on installed on 
different servers, the 
upgrade needs to be run 
twice, once on each 
server.
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4. A message 
recommends 
backing up your Web 
site before 
proceeding.

Important! Ektron 
strongly urges you to do 
this.

If you back up and 
then encounter any 
problems during 
installation, you can 
return your site to its 
state before the 
installation.
After backing up 
your site, click OK to 
proceed.

5. Choose an 
application directory. 
If you are not sure, 
use the default 
(C:\\Program 
Files\ 
Ektron\CMS400v50). 
This directory stores 
Ektron 
CMS400.NET  
components and 
utilities.
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6. Choose a site path 
directory. If you are 
not sure, use the 
default (webroot/
CMS400Example).
The site directory 
maintains Web site 
templates, the 
CMS400 Workarea 
directory, etc.
Note that the 
upgrade only 
updates the 
web.config file, 
Ektron 
CMS400.NET  
assembly files, 
Ektron 
CMS400.NET  script 
files, and Web 
Service components. 
It does not update 
your templates nor 
other files not 
mentioned above.

7. You are prompted to 
stop IIS. Ektron 
recommends doing 
so.

8. You are notified that files are moving to the sample site directory.

9. Your web.config file is updated with information needed to run Ektron CMS400.NET .
Only the section of the file between the <appsettings> tags and the section within <http modules> tags 
are affected. If other applications use the web.config file, the upgrade does not affect their sections.

Note: In the web.config file, the default setting for EnableMultilingual is off. Also, the 
DefaultContentLanguage is English (1033).

Document Management Add-on Upgrade
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10. The Documentation 
Add-on setup screen 
appears. Click Next.

11. You are prompted to stop the Indexing Service. Ektron recommends doing so.
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12. The Choose 
Destination Location 
screen appears. 
Enter the path of 
your current 
AssetManagement 
directory.

13. A dialog box appears warning you that the c:\inetpub\wwwroot\AssetManagement\ folder will still exist 
on your system. Ektron recommends removing this folder and its contents when the upgrade is complete. 
When upgrading, the AssetManagement folder is copied and to your site root folder.

Important: Do not remove this folder until the upgrade has successfully completed.
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14. The Choose 
Destination Location 
screen appears. 
Enter the folder 
where the Document 
Management 
Functionality will be 
installed. If you 
unsure, leave the 
default. If the 
CMS400 and 
Document 
Management Add-on 
are on the same 
server, the location 
should be the same 
as your CMS400 
site.

15. A question box appears. If your Document Management database is before version 1.11, click Yes. If your 
version is 1.11 or newer, click No.

Important: If you have not already backed up your assets database, do so before clicking Yes.
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What Happens Next?
After upgrading your site and rebuilding the solution, you are ready 
to use Ektron CMS400.NET.

If you did not run the database upgrade or language update during 
the installation, you need to do it manually. The next sections 
explain how to do that.

Upgrading Your Database
If the database upgrade was unsuccessful during installation, or 
you chose to do it outside of the install, you need to manually 
upgrade your database. Use the Database Upgrade utility supplied 
with the installation program to do so.

16. If you clicked Yes to upgrade your database, continue to the next step. If you clicked No, a warning box 
appears. This box reminds you to run the update script if your assets database version is before version 
1.11. If you are unsure whether you should run the upgrade script or not, run the upgrade script. Click OK.

17. The License Key warning box appears. The license keys contained in the assetmanagement.config file 
are not used with the new version of the Document Management. A New CMS400 license key that 
contains the DMS modifier is needed. You can obtain a new license by contacting Ektron Licensing at 
license@ektron.com. For information on updating the license key in the workarea, see the Administrator 
Manual section “Introduction to Ektron CMS400.NET” > “Modifying the Application Setup” > 
“Updating Setup Information”.

18. The Site Setup Completion Screen appears. Click Finish.

Mailto: license@ektron.com
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Prerequisites
Before you upgrade your database, be sure the following 
conditions are met:

• Ektron CMS400.NET is installed on your server. 
See ”Installing Ektron CMS400.NET” on page 41 or 
”Performing the Upgrade” on page 11 for more information.

• A DSN exists on your server that points to the old database. If 
one does not, see ”Creating a New DSN” on page 36.

With these two conditions met, you can upgrade your database.

Performing the Database Upgrade

WARNING! Ektron recommends backing up your database before performing an upgrade. For 
information on backing up a database, see ”Backing Up Databases” on page 22.

To perform the database upgrade:

1. Click the Windows Start button then follow this path: Programs > Ektron > CMS400 > Utilities > Data-
base Upgrade. (If this path does not work, click the dbupgrade.exe file, located under the C:\Program 
Files\Ektron\CMS400v50\Utilities folder.)
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2. The Ektron 
CMS400.NET 
Database Upgrade 
utility opens.

3. From the Product 
dropdown list, select 
CMS400. When you 
do, the database 
type (MS SQL) 
appears in the Type 
field.

4. Select the DSN for 
the database from 
the drop down list.

5. Specify the 
username and 
password that are 
needed to access 
the DSN, if required.

6. Select the Language of your content blocks. If your content blocks are in several languages, select the 
language of the majority of them.
After upgrading your database, all content blocks are assigned the language that you select. If some 
should not be in that language, find those content blocks and change their language. For more 
information, see the Ektron CMS400.NET Administrator manual section Special Features > Multi-
Language Support > Working with non-English Content > Resolving Conversion Issues.

Warning! 
If you select a language other than English, you must also open the webroot\CMS400Example\web.config file. 
Then, change the ek_DefaultContentLanguage variable to the language to which you assigned the content 
via the Language field above. In web.config, you must enter the new language’s locale ID value. A list of 
supported languages and their locale id values is in “Appendix A: List of Supported Languages,” in the Ektron 
CMS400.NET Administrator manual.

7. Click the Update button to execute the database upgrade utility.
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Backing Up Databases
To protect information contained within the database, it is 
recommended that you back it up before performing a database 
upgrade. This section describes how to backup and restore 
Microsoft SQL and MSDE2000 databases. The steps to perform 
each are in the following sections:

• ”Backing Up a Microsoft SQL Database” on page 23.

• ”Restoring a Microsoft SQL Database” on page 26.

• ”Backing Up an MSDE2000 Database” on page 29.

• ”Restore an MSDE2000 Database” on page 29.

8. After the database is 
upgraded, you are 
prompted to update 
the database with 
new messages.

Click Yes to 
continue, or No to 
update the strings at 
a later time.

For information about 
updating the strings later, 
see ”Updating 
Application Messages” 
on page 30.

9. A screen indicates that the upgrade is complete. Click the Finish button to end the upgrade.

10. Rebuild the site solution in Visual Studio.NET.
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Backing Up a Microsoft SQL Database
The following is an example of the steps for creating a backup of a 
Microsoft SQL database.

1. Open Microsoft SQL Server Enterprise Manager.
2. Click on Microsoft SQL Servers > SQL Server Group.

3. Click on the server where the database is located.
4. Click on Databases.

5. Choose the database to back up.
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6. Right click on Database and click All Tasks > Backup 
Database.

7. Add a location to which to back up the file.
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8. Set any options.

9. Click OK.
If the Backup is successful, this window appears.
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Restoring a Microsoft SQL Database
The following is an example of the steps for restoring a backup 
copy of a Microsoft SQL Database.

1. Open Microsoft SQL Server Enterprise Manager.
2. Click on Microsoft SQL Servers > SQL Server Group.

3. Click the server to which you want to restore the database.
4. Right click Databases > All Tasks > Restore Databases.

5. In the Restore as database field, type the name you want the 
database to be restored as.

6. Choose the Database radio button.
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7. In Parameters, choose a backup to restore.
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8. Set any options.

9. Click OK.
If the restore is successful, this window appears.
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Backing Up an MSDE2000 Database
Below are examples of syntax to backup your database and create 
a log of your backup. You may need to modify them or add 
switches based on the configuration of your database. To find a list 
of switches and their definitions, type osql -? at the prompt.

NOTE Switches used by OSQL are case sensitive.

To backup an MSDE2000 database, follow these steps.

1. Open a command window.

2. Add the following line after the prompt.
osql -d CMS400Example -E -n -Q "BACKUP DATABASE CMS400Example TO DISK = 'c:\CMS400Example.bak'"

3. Press <Enter>.
4. To make a log of the backup, add the following line after the 

prompt.
osql -d CMS400Example -E -n -Q "BACKUP LOG CMS400Example TO DISK = 'c:\CMS400Example _log.bak'"

5. Press <Enter>.

Restore an MSDE2000 Database
Below is an example of syntax to restore your database. You may 
need to modify it or add switches based on the configuration of 
your database. To find a list of switches and their definitions, type 
osql -? at the prompt.

To restore an MSDE2000 database, follow these steps.
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1. Open a command window.

2. Add the following line after the prompt.
osql -d master -E -n -Q “RESTORE DATABASE CMS400Example FROM DISK = ‘c:\CMS400Example.bak’”

3. Press <Enter>.

Updating Application Messages
Ektron CMS400.NET provides language support for French and 
German. If you are upgrading from a previous version and are 
using your old database, the translated strings are not included. 
Because of this, the installation includes a utility that lets you 
populate your old database with the translated strings.

Prerequisites
Before using the language upgrade utility, you must upgrade your 
version of Ektron CMS400.NET. For information on this, see 
”Performing the Upgrade” on page 11. During the upgrade, if you 
opt to keep your previous database, proceed with this section.

Using the Language Update Utility
To use the language update utility, follow these steps.

1. Go to Start > Programs > Ektron > CMS400 > Utilities > Application Strings Update.
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2. The Language Update Utility opens.
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3. Select the DSN for the database 
from the drop down list.

4. Enter a username and password with permissions to the DSN if required.
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5. Select the type of database you are 
using. It will be updated with the 
language strings.
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6. Select the action you want to 
perform.

• Repopulate - deletes all strings and 
repopulates the database

• Add New Strings - adds only new 
strings in the current release of 
Ektron CMS400.NET. (Recom-
mended if you changed existing 
strings)



Upgrading Ektron CMS400.NET

Ektron CMS400.NET Setup Manual,  Version 5.5 for .NET 2.0 Revision 1 35

7. Select the languages that you would 
like to be updated/added to the 
database.

8. Click the Update button.

9. When the language update is 
complete, the following screen 
appears.

10. Click OK to close the window.

11. Click Close on the Languages Update Utility window.
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Creating a New DSN
If a DSN was not automatically created during installation/upgrade, 
follow this procedure to access the ODBC Manager and point the 
DSN to the new database.

1. Access the ODBC Manager from the Control Panel.
2. The ODBC Data Source Administrator dialog is displayed.

3. Click the System DSN tab.
4. A list of system data sources appears.
5. Click Add.
6. The Create New Data Source window appears.
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7. Select the driver that best suits your version of MS-SQL server.
8. Click Finish.
9. The Create a New Data Source to SQL Server window opens.
10. Specify a name, description, and choose the SQL server to 

connect to. 
11. Click Next >.
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12. The next screen appears. Enter the necessary information 
about the authentication for the DSN, then click Next >.

13. The next screen appears.
14. Change the default database to the one that you created. Make 

any other adjustments on this screen if necessary. Then click 
Next >.
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15. The next screen appears. Choose whichever options you 
would like for the DSN, then click Finish.

16. The ODBC Microsoft SQL Server Setup window displays a 
summary of your settings.

17. Click Test Data Source to verify the data source.
18. If the DSN is good, you receive a message that the test 

completed successfully. If not, edit the DSN and make sure that 
everything is set up properly.

19. To finish, click the OK button at the bottom of the screen, and 
close the ODBC Manager.
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Troubleshooting Upgrade Problems

Problem Solution

After upgrade, Ektron CMS400.NET does not load 
properly. Also, an error icon appears next to your 
templates when you open the project in Visual 
Studio.NET, as illustrated below. 
The problem is that your .NET references need to 
be updated.

To verify the problem, open the Ektron 
CMS400.NET solution file in Visual Studio.NET 
(webroot\CMS400Example\CMS400Example.sln) 
and look at the template files. 
If your references are broken (as shown in the 
sample screen on the left), delete all Ektron 
references. Then, add new references with the 
same name from the 
webroot\CMS400Example\bin folder.

When viewing a page containing CMS400.NET 
Server controls or API calls, the page returns a 
fatal error Compiler failed with Error Code 2000. 
Detailed compiler output may say Fatal error 
BC2000: compiler initialization failed 
unexpectedly: The filename, directory name, 
or volume label syntax is incorrect.
This error message might appear after an 
upgrade.

See Ektron Knowledge Base article “ERRMSG: 
Compiler failed with Error Code 2000” 
(www.ektron.com/developers/
cms400kb.cfm?id=2029)

www.ektron.com/developers/cms400kb.cfm?id=2029
www.ektron.com/developers/cms400kb.cfm?id=2029
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Instal l ing Ektron CMS400.NET

This section explains how to install Ektron CMS400.NET through the 
following topics: 

• ”Before You Install” on page 41

• ”Performing the Installation” on page 41

• ”Document Management Client Install” on page 79

• ”Results of Installation” on page 81

• ”Changes to the CMS400 web.config File” on page 82

• ”After Installation” on page 83

• ”Setting Up an Additional Site” on page 83

• ”Moving a Site to Another Directory or Server” on page 86

Before You Install
Prior to installing Ektron CMS400.NET, complete these tasks.

1. Make sure that Internet Information Server (IIS) is installed in 
your server.

2. Install and configure your Web Application Server. For more 
information, see http://www.asp.net.

Performing the Installation
NOTE The installation program checks to see if MSSQL is installed on your server. If it is 

not, it will attempt to install MSDE2000.

http://www.asp.net
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Installing Ektron CMS400.NET involves these actions. The 
installation program guides you seamlessly through them.

Action What it does For details, see 

Copy installation files 
to C:\Program Files

• ensures system require-
ments

• installs non-working copy of 
files needed to set up site

”An introductory screen appears. Click 
Next to proceed.” on page 43

Set up a site • moves files based on 
selected Web folder

• creates IIS application 
directories

• sets upload folder permis-
sions

• updates web.config (path, 
version, and build number)

”Setting up a Site” on page 48

Set up a database • references database folder 
for scripts needed to cre-
ate a database

• creates new tables and 
populates them

• adds and sets user permis-
sions

• updates the web.config file

• tests database connection

”Setting up a Database” on page 52

Set up Ektron 
Document 
Management Add-
on

• set up all files and folders

• set up database

• set up indexing service

”Complete Document Management 
Add-on Setup” on page 57

Set up Ektron 
Document 
Management Add-
on  user

• sets a user to communicate 
with the /dmdata/ folder.

”Adding a Document Management User 
Account” on page 67

Set up a user (MS SQL 
only)

• set up SQL user informa-
tion

”Set Up a User for the CMS400 
Database” on page 72
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Running the Installation and Setup Program

IMPORTANT! If you are installing Ektron CMS400.NET and the Document Management Add-on 
on separate servers, you need to run the install twice, once on each server. You 
can choose whether you want a CMS400 or Document Management Add-on 
install during the site setup portion of the install. See Also: ”Complete Document 
Management Add-on Setup” on page 57.

Create a new DSN • Create a new DSN that 
points to the MS-SQL data-
base

”Creating a New DSN” on page 36

Action What it does For details, see 

Step Setup Screen

1. Go to the Ektron Web site (http://www.ektron.com/download.cfm?product_id=260&purchase=0) and 
download Version 5.5 for .NET 2.0 of Ektron CMS400.NET . 

2. Double click the downloaded Ektron CMS400.NET executable file.

3. An introductory screen appears. Click Next to proceed.

http://www.ektron.com/download.cfm?product_id=260&purchase=0
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4. A screen displays 
Ektron’s License 
Agreement. 
Please read the 
agreement.

• Click I Accept... to 
accept the agree-
ment.

• Click I do not 
accept. if you do 
not accept the 
agreement. This 
action ends the 
setup program.

5. A Question Box appears. It ask you if you want to install the Adobe IFilter 6.0, select Yes. The Document 
Management Add-on needs this software to index PDF files.

Step Setup Screen
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6. Select Complete 
to install all 
possible 
components.
Or select Custom 
to select which 
components to 
install. 

Step Setup Screen
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7. The installation 
program copies 
the necessary files 
to the C:\Program 
Files folder. 
During this 
process, the 
installation grants 
the Everyone user 
group write 
permissions to the 
following system 
folders:

• \CMS400Example\Up
loadedImages

• \CMS400Example\Up
loadedFiles

• \CMS400Example\Da
tabases

After completing 
the installation, 
you should further 
configure your 
permissions 
based on your 
network security 
model before 
using Ektron 
CMS400.NET.

Step Setup Screen
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8. The Adobe iFilter 
Setup screen 
appears. Click 
Next if you want to 
install the ability to 
search through 
PDF documents.
Otherwise, click 
Cancel.
If you proceed, 
you are asked to 
agree to Adobe’s 
license agreement 
and to select a a 
destination folder.
Then, the filter is 
installed.

9. A screen indicates 
that the 
installation is 
complete. 

10. If you have an 
MS-SQL 
database, 
proceed to 
”Setting up a Site” 
on page 48.
If you are 
installing an 
MSDE database, 
you are prompted 
to restart your 
computer. Ektron 
recommends 
doing a restart 
now, before 
continuing the 
installation.

Step Setup Screen



Installing Ektron CMS400.NET

Ektron CMS400.NET Setup Manual,  Version 5.5 for .NET 2.0 Revision 1 48

If you restart now, the site setup procedure begins immediately upon completion of the restart.
If you restart later, you can launch the site setup from Start > Programs > Ektron > CMS400 > Utilities 
> CMS400 Site Setup.

Note: If you have any problems installing MSDE, you can download it directly from Microsoft’s 
Web site at http://www.microsoft.com/sql/msde/downloads/download.asp.

Setting up a Site

11. This screen 
appears. It lets 
you set up a Web 
site.
To set up a site, 
the installation 
copies the 
following folders 
from C:\Program 
Files\Ektron\CM
S400v50 to the 
Web root folder 
you specify:

• BIN

• workarea

• documentation

• uploaded files 
and uploaded 
images

• a login page

• the VS.NET 
solution file

Step Setup Screen

http://www.microsoft.com/sql/msde/downloads/download.asp
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12. Select the type of 
site you want to 
install:

• CMS400 + Docu-
ment Manage-
ment Add-on - 
installs all 
CMS400 and Doc-
ument Manage-
ment supporting 
files and folders.

• CMS400 Setup - 
installs all tem-
plates and sup-
porting files for 
CMS400.

• Document Man-
agement Add-on 
- installs all sup-
porting files, fold-
ers and services 
for Document 
Management. See 
Also: ”Complete 
Document Man-
agement Add-on 
Setup” on page 57

• CMS400 Data-
base Setup - Sets 
up a database in 
selected folder. 
You can choose 
sample or mini-
mal database. 
See Also: ”Setting 
up a Database” on 
page 52

• Upgrade CMS 
Site / Reinstall - 
Use if you have an 
earlier version of 
Ektron 
CMS400.NET . 
See Also: 
”Upgrading Ektron 
CMS400.NET” on 
page 9

Important! If you are installing Ektron CMS400.NET and the Document 
Management Add-on on separate servers, you need to run the install twice, once 
on each server.

Step Setup Screen
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13. Enter license keys 
for the Ektron 
CMS400.NET  
and 
WebImageFX, if 
you have them. 
License keys are 
typically emailed 
to your 
organization when 
you request a 
copy of the 
application.
When cutting and 
pasting license 
keys, keep the full 
license key intact 
without adding or 
deleting 
characters.
If you do not have 
the license keys 
now, you can 
insert them later. 
See “Configuring 
Ektron 
CMS400.NET” in 
the Administrator 
manual for details.

Step Setup Screen
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14. Select the type of 
site you want to 
install: Example 
site or Minimal. 
The sample site 
contains

• Two users - 1 
administrator, 1 
editor

• Sample content

• Sample images

• Fonts

The minimal site 
lacks sample 
content and 
images. It only 
includes 
necessary files 
and the default 
administrator 
(admin/admin).

15. If your server 
operating system 
accommodates 
multiple Web sites 
(for example, 
Windows Server 
2003), select the 
site to which you 
want to install 
Ektron 
CMS400.NET  
from the 
dropdown list.
Otherwise, accept 
the default.

Step Setup Screen
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16. On the Host 
screen, specify 
the host name 
(which defines the 
URL) that will be 
used to access 
your Web site.
The host name 
also configures 
variables during 
the installation.
It can be any of 
the following:

• An IP address 
(123.456.7.890)

• A server name 
(WebServer1234)

• A domain name 
(www.ektron.com)

Setting up a Database

Your database contains information such as users and content blocks. Ektron CMS400.NET  is compatible 
with the following databases:

• SQL Server 2000

• Microsoft MSDE 2000 (a free, scaled-down version of SQL database. For more information see, http://
www.microsoft.com/sql/msde/default.asp.). If your server does not have SQL Server 2000 or MSDE, 
MSDE is installed.

17. You are asked if 
you want to set up 
a database.
Click Yes to do so.

Step Setup Screen

http://www.microsoft.com/sql/msde/default.asp
http://www.microsoft.com/sql/msde/default.asp
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The database setup 
program 

• checks for MSDE 
or SQL server. If 
SQL is installed 
on your server, a 
SQL database is 
set up. If MSDE is 
installed, an 
MSDE database is 
set up. If neither is 
detected, MSDE is 
installed then an 
MSDE database is 
set up.

• loads database 
tables

• updates the 
web.config file 
with information 
about your data-
base connection, 
based on your 
responses

Step Setup Screen
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18. Enter the name of 
the database you 
are creating. If you 
are installing the 
sample site, 
accept the default.
If you are setting 
up your own site, 
assign a different 
name.

19. This screen 
prompts for 
database 
connection 
information. 
Server - 
(local)\CMS400M
SDE2000 is the 
default value for 
the MSDE server 
installed with 
Ektron 
CMS400.NET . To 
install this, accept 
the default.
Otherwise, enter a 
SQL or MSDE 
server that already 
exists. For SQL, 
this would typically 
be (local).

Step Setup Screen
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Username - Enter the username you will use to access the database. If you are installing the MSDE 
database delivered with Ektron CMS400.NET , the username is sa.
Password - Enter the password you will use to access the database. If you are installing the MSDE 
database delivered with Ektron CMS400.NET , the password is ektron.

Note: If you want to use NT authentication, leave the username and password blank. This will set up a 
trusted connection.

After you complete the screen, the installation program creates a database using the provided information. 
Then, it tests the database connection to verify that the information is valid and that you can save content.
If the database name was used previously, you are informed and asked to assign a different name.

If you see the following error message, change the Destination Folder to program 
files\ektron\cms400v50\sitesetup\database.

20. Click Yes to install 
the Indexing 
Service for the 
Document 
Management Add-
on.

Step Setup Screen
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21. Click Finish. The 
site setup portion 
of the install is 
complete.

22. The Ektron 
CMS400.NET + 
Document 
Management Add-
on installation is 
complete.
Click Finish.

Step Setup Screen
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Complete Document Management Add-on Setup
This section explains the process of doing a complete Ektron 
Document Management Add-on only setup. If you ran the CMS400 
+ Document Management Add-on, you do not need to run this 
setup.

Step Setup Screen

1. Run the 
CMS400.exe.

Note: If you arrived at this section of documentation from the CMS400.exe steps 
you do not need to re-run CMS400.exe.

2. When you get to 
the CMS400 Site 
Setup screen, 
choose 
Document 
Management 
Add-on.
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3. The Adobe iFilter 
Setup screen 
appears. Click 
Next if you want to 
install the ability to 
search through 
PDF documents.
Otherwise, click 
Cancel.
If you proceed, 
you are asked to 
agree to Adobe’s 
license agreement 
and to select a a 
destination folder.
Then, the filter is 
installed.

4. Enter the path 
where the Ektron 
Document 
Management 
Add-on  install 
files are located. 
The default 
location is:
C:\Program 
Files\Ektron\CMS
400v50\DMS400v
11\

Step Setup Screen
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5. If your server 
operating system 
accommodates 
multiple Web sites 
(for example, 
Windows Server 
2003), select the 
site to which you 
want to install 
Ektron 
Document 
Management 
Add-on  from the 
dropdown list.
Otherwise, accept 
the default.

6. Enter the directory 
where Ektron 
Document 
Management 
Add-on  will be 
installed.
If you are unsure, 
leave the default 
location.

Step Setup Screen
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7. Enter the host 
name you will use 
to access this site. 
If you are unsure, 
use the default

8. On the Secure 
Asset Storage 
Location screen, 
select a 
destination folder 
or use the default.

Step Setup Screen
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9. On the Indexing 
Service Catalog 
Screen, enter the 
following.

• Name - The name 
of the Asset Cata-
log. It must be 
unique.

• Location - The 
folder where the 
asset catalog will 
reside.

Step Setup Screen
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10. The create a 
Document 
Management 
user account 
question box 
appears.

• Would you like 
Document Man-
agement to cre-
ate a user account 
on your system?

- Click Yes, 
Ektron 
Document 
Managemen
t Add-on  
creates a 
user for you.

- Click No to use 
an existing 
account.

Note: If you click No, 
go to ”Adding a 
Document 
Management User 
Account” on page 67. 
When finished, return 
and continue with next 
step.

Step Setup Screen
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11. This screen 
prompts for 
database 
connection 
information. 
Server - 
(local)\CMS400M
SDE2000 is the 
default value for 
the MSDE server 
installed with 
Ektron 
CMS400.NET . To 
install this, accept 
the default.
Otherwise, enter a 
SQL or MSDE 
server that already 
exists. For SQL, 
this would typically 
be (local).

12. At the Ready to 
Install the 
Program screen, 
your choices are:

• Click Install to 
Install the program

• Click Back to 
change any instal-
lation settings

• Click Cancel to 
cancel the setup

Step Setup Screen
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13. The setup 
program installs 
all necessary files 
and sets the 
proper 
permissions for 
users.

14. A completion 
message is 
displayed.
Click Finish.

Important!: Continue 
to the next step.

Step Setup Screen
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15. The Document 
Management Add-
on installation is 
complete.
Click Finish.

Important!: Continue 
to the next step to 
register your 
Document 
Management Add-on 
with your 
CMS400.NET

Step Setup Screen
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16. Enter the 
CMS400.NET  
Workarea, click 
Settings > 
Configuration > 
Asset Server 
Setup.

17. Click the Edit 
button.

18. Add the location of 
the AMS in the 
Asset 
Management 
Server Address 
(URL) field.

19. Click Save.

Step Setup Screen
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Adding a Document Management User Account
The Ektron Document Management Add-on needs a user to set 
permission on that can communicate through basic authentication. 
You can have the installation add an account, select an existing 
account from your server or domain, or create a new one. If Ektron 
Document Management Add-on and Ektron CMS400.NET are 
installed on different systems, the account must be usable by both 
systems over the domain.

During the installation of Ektron Document Management Add-on, 
you have a choice to:

• let the Ektron Document Management Add-on create a user 
account called EKT_ASSET_USER

• create a new user account

• use an existing user account

Congratulations, The Ektron Document Management Add-on  is now installed and connected to the 
CMS400.NET

20. If installing on Microsoft Windows Server 2003, the Web Folders install starts. To follow along with the 
install, see ”Using Microsoft Windows Server 2003 as a Client (Web Folders Setup)” on page 70. Return 
to next step when complete.
If you are not installing on Microsoft Windows Server 2003, continue to the next step.

Step Setup Screen
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The user is authenticated to write to C:\inetpub\wwwroot\dmdata.

Step Description

1. The user information 
screen appears.

Important: Ektron 
Document Management 
Add-on  needs a user to set 
permission on that can 
communicate through basic 
authentication. You can select 
an existing account or create 
a new one. If Ektron 
Document Management 
Add-on  and CMS400.NET  
are installed on different 
systems, the account must be 
usable by both systems over 
the domain.

• User Name: Type in a 
user name or click 
Browse to find a user. If 
you click browse continue 
to ”Browse for a User 
Account.” on page 69. 
Then return, enter a 
password and click Next.

• Password: Type the 
password for the user.

• New User Information: 
Select this button to cre-
ate a new user. If you 
click the New User Infor-
mation button, see”New 
User Information” on 
page 69

Click Next to continue. Return 
to ”This screen prompts for 
database connection 
information.” on page 63
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Browse for a User Account.

• Domain or Server: Enter 
a domain or server name 
or click Browse to 
choose one from a list.

• User name: Enter a user 
name or click Browse to 
choose one from a list.

Note: You must specify a 
domain or server before 
browsing to a user.

Click OK. Return to ”The user 
information screen appears.” 
on page 68

New User Information

• Domain or Server: Enter 
a domain or server name 
or click Browse to 
choose one from a list.

• Group: Enter a group in 
which to add the user or 
click Browse to choose 
one from a list.

• User name: Enter a user 
name.

• Password: Enter a pass-
word for the user.

• Confirm Password: 
Confirm the password.

Click OK. Return to ”This 
screen prompts for database 
connection information.” on 
page 63

Step Description
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Using Microsoft Windows Server 2003 as a Client (Web 
Folders Setup)

Web Folders Setup for Microsoft Windows Server 2003

NOTE You only need to run the Web Folders Setup if there is a problem during the 
install. The Ektron Document Management Add-on install performs the setup 
when needed.

The MSDAIPP.DLL is no longer shipped with Microsoft Windows 
Server 2003, making communication with Web folders impossible. 
To correct this, Ektron Document Management Add-on setup runs 
the Web folder setup when it detects Microsoft Windows Server 
2003.

The following steps explains installing Web Folders. You will need 
to obtain a copy of the webfldrs.msi file.

Symptom Resolution

You receive the following error 
message:
Windows Server 2003 no longer 
ships MSDAIPP.DLL, thus 
connecting to an FPSE server 
through Webfolders, is no 
longer possible.

Per MS Licensing, you can obtain webfldrs.msi from any down-level OS, 
or any Office product that shipped before Windows2003 (not Office 2003) 
and install the WebFolders client. Doing so will keep you compliant with 
licensing. 
Installing WebFolders from Office 2003 is only allowed if you have an 
Office 2003 license for each Windows2003 server you plan to install 
WebFolders on.

Step Setup Screen

1. Double click the webfldrs.msi file.

2. The Web Folders install 
screen appears. Click 
Next to continue.
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3. The Web Folders 
Identity dialog box 
appears.

• Add your Name.

• Add your Organization.

• Click Next.

4. The Web Folders 
Product ID dialog box 
appears.
This dialog box displays 
the your product ID 
number.

• Click Next.

5. The Web Folders 
Selection Choice dialog 
box appears.

• Complete - installs all 
components.

• Custom - you choose 
the components to 
install.

• Typical - installs the 
most frequently used 
components.
After making a 
selection, click Next.

Step Setup Screen
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Set Up a User for the CMS400 Database
The installation automatically sets up user information based on 
the data collected during setup. However, if there is a problem 
creating the user, this section describes how to set up a user 
manually.

6. The Verify Ready All 
dialog box appears.

• Click Install Now.

7. The Action dialog box 
appears. The Setup is 
installing Web folders.

8. The We Are Done 
dialog box appears.

• Click OK.

Step Setup Screen



Installing Ektron CMS400.NET

Ektron CMS400.NET Setup Manual,  Version 5.5 for .NET 2.0 Revision 1 73

Step Setup Screen

1. In the SQL Enter-
prise manager, 
select Security > 
Logins. 
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2. On the Login 
Properties dialog, 
select New Login. 
From the New 
Login dialog, click 
IUSER, Add, and 
OK.

Step Setup Screen
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3. On the Database 
Access tab, click 
the 
cms400example 
database. Then, 
assign permission 
to read and write 
to that database 
(as illustrated.)

Step Setup Screen
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4. Run the Grant Permission Script.

Note: Before doing this, review your users and their permissions. Adjust as necessary for your configuration. 
Also, if you use Windows Authentication and all users are domain users (and the database administrator 
wants it this way), you may not have to perform this step.

Follow these steps to do that.

• Open the SQL Query Analyzer.

• From the dropdown list, select the CMS400.NET  database.

• Click File > Open. Open C:\Program 
Files\Ektron\CMS400v52\SiteSetup\Database\grantpermissionsscript.sql.

• Within that file, replace [MACHINENAME or DOMAINNAME\USERNAME] with your domain name, backslash 
(\), and ASPNET (the ASP.NET machine account). For example, [ws10080\ASPNET].

• Press the Execute Query button ( ).

• Replace the text between square brackets with with your domain name, backslash (\), and the IIS Inter-
net Guest Account. For example, [ws10080\IUSR_ws10080]. Press the Execute Query button.

• If using SQL server authentication, replace the text between square brackets with your domain name, 
backslash (\), and the SQL server authentication name. Press the Execute Query button.

• If using SQL server authentication, replace the text between square brackets with the SQL server authen-
tication name only. Do not include the domain name. Press the Execute Query button.

Step Setup Screen
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Possible Error Messages During Installation
Error

Possible Causes and Solutions

Possible cause Suggested solution

User does not have permission 
to create objects

Grant user permission to create objects. For information 
on how to, read IIS Security help topic “Setting NTFS 
Permissions for a Directory or File.”
http://localhost/iishelp/iis/htm/core/iidfpsc.htm

IIS is not running Restart IIS. For information on how to, read IIS help 
topic “Starting and Stopping Sites.”
http://localhost/iishelp/iis/htm/core/iiststp.htm

Host is not localhost Install Ektron CMS400.NET  on localhost machine only.

http://localhost/iishelp/iis/htm/core/iidfpsc.htm
http://localhost/iishelp/iis/htm/core/iiststp.htm
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Error
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Cause and Solution

Document Management Client Install
This section explains the steps to install the Ektron Document 
Management Add-on on client systems. The client setup needs to 
be performed on all client systems that connect to a server with 
Ektron Document Management Add-on installed on it.

If you have a large client base to deploy, you should use 
deployment software. A good Web site for deployment software 
information and links is http://appdeploy.com/.

Cause Solution

You installed Ektron CMS400.NET  for .NET 2.0 
but have the 1.1 .NET framework.

Install the .NET 2.0 framework.
Or, install the version of Ektron CMS400.NET  for the 
1.1 .NET framework.

Step Setup Screen

1. Double click the executable file dms400client.exe. The file’s default location is C:\Program 
Files\Ektron\CMS400v50\DMS400v11\AssetManagement\ektasset\clientinsta
ll

Note: This step is not necessary if the install was launched from the server setup. 
If you are using Netscape Navigator or Mozilla Firefox as a client, you need to run this install.

http://appdeploy.com/
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2. The following 
screen appears. 
Click Next to 
install Ektron 
Document 
Management 
Add-on  client.

3. The setup 
program installs 
all necessary 
files.

Step Setup Screen
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Results of Installation

File Locations
By default, the installation inserts files into two locations on the 
server:

• C:\Program Files\Ektron\CMS400v50: sample and minimal 
databases, documentation, utilities, site setup files (for creating 
additional sites)

• C:\Inetpub\wwwroot\CMS400Example: bin folder, Web Services, 
scripts, supporting files, uploaded files and images, graphics 
used in the application, CustomAPI (used to customize Ektron 
CMS400.NET), etc.

NOTE The bin folder stores Ektron CMS400.NET’s binary executable files. The .NET 
environment automatically searches this folder when looking for dll files.

4. A completion 
message is 
displayed.

Click Finish to 
complete the 
installation.

Step Setup Screen



Installing Ektron CMS400.NET

Ektron CMS400.NET Setup Manual,  Version 5.5 for .NET 2.0 Revision 1 82

File Permissions
During installation, the everyone group is given permission to 
create folders in the following directories:

• C:\Inetpub\wwwroot\CMS400Example\uploadedfiles

• C:\Inetpub\wwwroot\CMS400Example\uploadedimages

Ektron recommends setting up .NET user accounts to authorize 
users to add, edit, and delete folders in the installation folder, 
C:\Inetpub\wwwroot\CMS400Example\.

Changes to the CMS400 web.config File
IMPORTANT! If you perform a complete CMS400 and Document Management Add-on install, 

there are two web.config files that are created. One for the CMS400 located in /
webroot/CMS400Example/ and one located in /webroot/CMS400Example/
AssetManagement/ for the Document Management Add-on. This section refers to 
the CMS400 web.config file.

See Also: ”Managing the web.config File” on page 95

After you install Ektron CMS400.NET, the web.config file is updated 
as follows.

After you run the database setup utility, the web.config file is 
updated as follows.

web.config setting Assigned this value by installation

ek_sitePath webroot/CMS400Example

ek_buildNumber current build number of Ektron 
CMS400.NET

ek_version current version of Ektron CMS400.NET

Line Description Value (if default 
accepted)

ek_dbCatalog the database name you 
assigned
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After Installation
Ektron strongly recommends configuring a secure socket layer 
(SSL), especially if you are using Active Directory Integration. SSL 
encrypts passwords that are otherwise sent as clear text to the 
Ektron CMS400.NET server. See ”Configuring SSL” on page 113 
for more information.

Setting Up an Additional Site
After installing Ektron CMS400.NET, it is easy to create another site. 
While creating the new site, you can create a sample or minimal 
site and database. To create a site for your content, you would 
typically install a minimal site and database, then create your Web 
page templates. Later, you can add users and content.

ek_dbServer the database server name 
(MSSQL or MSDE)

(local)\CMS400MSDE2000

ek_dbConnectionType database connection type 
(MSDE or SQL)

sql

ek_dbUsername user from CMS400 database 
(only used for SQL)

sa

ek_dbPassword password from CMS400 
database (only used for SQL

Ektron

ek_dbTrustedConnection false - (default) sets 
authentication to SQL Server. 
Username and password are 
required.
true - sets authentication to 
Windows. Windows handles 
security when connecting to 
database.

false

ek_sitePath path from the root of web server

Line Description Value (if default 
accepted)
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To set up an additional site, follow these steps.

• ”Step 1: Set up New Site” on page 84

• ”Step 2: Set up New Database” on page 84

• ”Step 3: Create Project in Visual Studio.NET” on page 85

Step 1: Set up New Site
1. Create a new folder in the Web root folder to contain the site 

files.
2. From the Windows Start menu, follow this path:

Start > Programs > Ektron > CMS400 > Utilities > SiteSetup
3. Follow the steps for creating a new site, as described in 

”Setting up a Site” on page 48. When prompted to select a 
folder to which you want to install the files, choose the folder 
you created in Step 1.

Step 2: Set up New Database
After installing an Ektron CMS400.NET site, it is easy to create a 
new, starter database. You can create either a sample or minimal 
database. If you want to create a database for your content, you 
typically install a minimal database.

To set up a database, follow these steps.

1. From the Windows Start menu, follow this path:
Start > Programs > Ektron > CMS400 > Utilities > SiteSetup

2. On the first screen that appears, choose Database Setup 
only.



Installing Ektron CMS400.NET

Ektron CMS400.NET Setup Manual,  Version 5.5 for .NET 2.0 Revision 1 85

3. Follow the steps for creating a new database, as described in 
”Setting up a Database” on page 52. Be sure to assign the 
database a name other then the default. Also, when asked to 
enter a SQL or MSDE server, enter the server name or IP 
address. 

WARNING! Do not use the instance name (CMS400MSDE2000) -- it will cause an error.

Step 3: Create Project in Visual Studio.NET
To work with the new site in Visual Studio.NET, you need to create 
a new project for it. To do that, follow these steps.

1. Navigate to the folder of the new site you created.
2. Double click Ektron CMS400.NET’s solution file. If you are using 

the minimal database, the file is CMS400Min.sln. If you are using 
the sample database, the file is CMS400Example.sln.
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At this point, you can build the project and log in. If you cannot log 
in because you have not set up the license key, you can use the 
builtin account: the username is builtin and password is builtin. 

WARNING! You should only use the builtin account temporarily. As soon as possible, you 
should insert the license key and log in under a user name assigned in Ektron 
CMS400.NET.

To learn about creating templates and using server controls, see 
the Ektron CMS400.NET Developer’s Manual section “Ektron 
CMS400.NET Server Controls.” 

Moving a Site to Another Directory or Server
Use this procedure to move an Ektron CMS400.NET Web site to a 
new folder or even a different server. For example, you complete 
work on a site that resides on a development server and want to 
move it to a production server.

Within this documentation, the original site’s folder is referred to as 
the source directory, and the new site’s folder is called the 
destination directory. The directories can reside on the same 
server or different ones.

Moving the site consists of the following major steps. Each step is 
described below.

• ”Step1: Set up an IIS Site on the Destination Server” on 
page 87

• ”Step 2: Copy Files to Destination Directory” on page 88

• ”Step 3: Set Security on New Folders” on page 88

• ”Step 4: Make the New Directory an IIS Application” on page 89

• ”Step 5: Back up the Database” on page 90

• ”Step 6: Create a New Database” on page 91

• ”Step 7: Restore the Database” on page 92

• ”Step 8: Set Security on the Copied Database” on page 94

• ”Step 9: Update web.config on the Destination Site” on page 94
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Moving a Site vs. Using the Site Replication Feature
In addition to the Site Move procedure described below, Ektron 
CMS400.NET offers a Site Replication feature. That feature 
automatically pushes new and updated site files to the production 
server. Site Replication is especially useful when your site contains 
sensitive information (for example, pricing) that needs to be 
carefully reviewed for quality assurance before it goes live. For 
more information, see the Ektron CMS400.NET Administrator 
manual section “Site Replication.”

When You Would Use the Site Replication feature

You'd use the Replication feature in these cases.

• Moving a site from staging to production

• Distributing a site among load-balanced servers

When You Would Use the Move Site Procedure 

You'd use the Move Site procedure in these cases.

• Moving a site from staging to production if you do not have the 
Replication feature

• Distributing a site among load-balanced servers if you do not 
have the Replication feature

• The initial move of a site up to a shared server (or any other 
server on which you cannot run the .exe installer). 
Subsequently, you could use Site Replication if you have it.

• Moving a site to a new server. For example, you purchase a 
new server to replace your existing one.

• Moving a site between two servers that are not connected by a 
network.

Step1: Set up an IIS Site on the Destination Server

NOTE This procedure assumes your Web server runs Windows 2003 server.
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1. On the destination server, go to Start > Control Panel > 
Performance and Maintenance > Administrative Tools > 
Internet Information Services.

2. Click the plus sign (+) next to the computer’s name so that you 
can see the Web Sites folder.

3. Right click the Web Sites folder and select New Web Site.
4. The Web Site Creation wizard walks you through the steps of 

creating a new Web site.
5. At the TCP Port field, make sure the IP address/host header/ 

port combination do not conflict with an existing Web site. For 
example, if the destination server already publishes a Web site 
on IP address 172.23.23.231 with host header 
dev.example.com on port 80, your new site could use the same 
settings on port 81. The new site is accessible through http://
dev.example.com:81/.

6. When prompted for the path to the new site, create a new 
folder for the site in the destination server's file system.

7. When prompted to assign permissions to the new folder, 
assign read, write and run scripts permissions.

Step 2: Copy Files to Destination Directory
1. In the Web root of the destination directory, create a folder with 

the same name as the folder in the source directory.

NOTE You do this in order to set the destination site on the same URL path as the 
source site on the source server. For example, if you the source site’s login page 
is http://localhost/MySite/login.aspx and you're moving it to 
dev.example.com port 81, place the destination site at http://
dev.example.com:81/MySite/login.aspx.
It is important for both sites to use the same URL path because Ektron 
CMS400.NET uses root relative pathing in links to pages and images. This 
means that any managed content item can be displayed on any page in the Web 
site. Since the path may be embedded in hyperlinks and image paths, changing 
the URL path on the destination server may cause problems.

2. Copy all files in the source directory to the destination directory.

Step 3: Set Security on New Folders
This procedure lets Ektron CMS400.NET users upload files to the 
library.
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1. Within IIS manager, navigate to the folder created in ”Step 2: 
Copy Files to Destination Directory” on page 88.

2. For the uploadedfiles and uploadedimages directories, right 
click on the folder and choose Properties. On the Directory 
tab of the Properties dialog, ensure that the Write attribute is 
checked.

3. Exit IIS manager.
4. Open Windows Explorer.
5. Navigate to new Web site’s folder.
6. Right click the uploadedfiles directory, and choose Properties.
7. On the General tab of the properties dialog, ensure the Read-

Only attribute is not checked.
8. On the Security tab of the properties dialog, ensure that the IIS 

anonymous user (usually named “IUSR_COMPUTERNAME”) 
has Write permission.

9. Right click the uploadedimages directory, and choose Properties.
10. Repeat steps 7 and 8 for the uploadedimages directory.

Step 4: Make the New Directory an IIS Application
1. Within IIS manager, right mouse click the folder created in 

”Step 2: Copy Files to Destination Directory” on page 88.
2. Select Properties.
3. In the Application Settings area, click Create.
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4. Click OK.

Step 5: Back up the Database

WARNING! Do not use SQL Server Data Transformation Services to move the database. This 
feature is not compatible with Ektron CMS400.NET.

Ektron recommends backing up the database in the source folder 
then restoring the database backup to the destination folder. This 
procedure is described below.



Installing Ektron CMS400.NET

Ektron CMS400.NET Setup Manual,  Version 5.5 for .NET 2.0 Revision 1 91

1. In the Ektron CMS400.NET source folder, open the web.config 
file and verify the name of the database. The database name 
appears after key="ek_dbCatalog" value= .

2. On the source server, open SQL Enterprise Manager and 
navigate to the database you identified in Step 1.

3. Right mouse click the database then select All tasks > 
Backup database.

4. Select a destination file name by clicking the Add button in the 
Destination area of the SQL Server Backup screen.

Step 6: Create a New Database
1. On the Destination server, open SQL Enterprise Manager.
2. Expand the display until you see the Databases folder.
3. Right click the Databases folder.
4. Choose New Database....
5. Assign a name to the database.
6. The remaining options can remain as defaults, or you can be 

edit them as needed.
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Step 7: Restore the Database
Restore the database to the new destination folder. To do this, 
follow these steps.

1. Right click the database you created in ”Step 6: Create a New 
Database” on page 91.

2. Select All Tasks > Restore database.

3. In the Restore as database field, verify that the database you 
created in Step 6 appears.

4. In the Restore section, click From device (circled above).
5. Click the Select Devices button (circled above).
6. The Choose Restore Devices screen appears. Click the Add 

button (circled below).
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7. On the Choose Restore Destination screen (below), select File 
name and navigate to the backup file you copied to the 
destination folder.

8. Press OK three times. SQL copies the data to the database 
you created in ”Step 6: Create a New Database” on page 91.
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Step 8: Set Security on the Copied Database
1. This procedure is described in ”Set Up a User for the CMS400 

Database” on page 72. Do this for the following users.

• IUSER

• ASPNET User

Step 9: Update web.config on the Destination Site
1. Within the destination site folder, open the web.config file.
2. Modify the following values as needed.

Web.config 
element

How to Modify

ek_dbCatalog The name of the new database, if you changed it

ek_dbUsername The database user, if you created one

ek_dbPassword The database password, if you created one

ek_dbTrustedConnecti
on

Whether the new database uses a trusted connection

ek_sitePath The path to the new folder, relative to the server’s webroot folder

WSPath The full path to the folder that stores the Web Service URL for Server 
Controls at design time
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Managing the web.config File

Ektron CMS400.NET’s web.config file lets you control many key 
functions of the content management system. When you install 
Ektron CMS400.NET, web.config is placed into webroot/
CMS400Example.

This section explains the settings in the web.config file.

NOTE In CMS300 and CMS200, most web.config settings were handled in the setup.xxx 
file.

If your server is currently running another .NET application, you 
must merge that web.config file with this one.

Note that all Ektron CMS400.NET settings begin with ek_ and reside 
within the <appSettings> tags of the web.config file. This prefix 
distinguishes Ektron CMS400.NET’s tags from others.

Settings in the web.config File

Setting Description

enableAnalytics Determines whether Ektron CMS400.NET  tracks content analytics 
statistics in the database.
For more information, see the Ektron CMS400.NET  Administrator 
manual > "Content Analytics Feature" > "Enabling the Content 
Analytics Feature."
Possible values are true and false.

appendToIISLog Determines whether Ektron CMS400.NET  tracks content analytics 
statistics in the IIS Log.
For more information, see the Ektron CMS400.NET  Administrator 
manual > "Content Analytics Feature" > "Writing to the IIS Log."
Possible values are true and false.
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recordsBeforeWrite Used to determine the frequency of writing content analytics 
statistics to the database (in number of page views).
For more information, see the Ektron CMS400.NET  Administrator 
manual > "Content Analytics Feature" > “Specifying the Frequency of 
Writing to the Database.”

timeBeforeWrite Used to determine the frequency of writing content analytics 
statistics to the database (in seconds). 
For more information, see the Ektron CMS400.NET  Administrator 
manual > "Content Analytics Feature" > “Specifying the Frequency of 
Writing to the Database.”

ek_dbCatalog The name of the SQL database you are using. 

ek_dbServer The name of the database server to which Ektron CMS400.NET 
is installed. If installed locally, the value is localhost. This value is 
set during installation, at the Host screen.

ek_dbConnectionType Should be SQL for SQL authentication.

ek_dbDatabase MSSQL is currently the only supported database

ek_dbUsername If required, specify the username used to connect to the DSN. This 
user account must have at least read and write permissions to the 
database.

Note: This value can be blank if you are using Windows 
authentication.

ek_dbPassword If required, specify the password for the username given. It should 
match your database name.

Note: This value can be blank if you are using Windows 
authentication.

ek_dbTrustedConnection For SQL authentication, set to false. In this case, username and 
password are required.
For Windows authentication, set to true. If set to true, Windows 
handles security when connecting to the database. In this case,.NET 
impersonates the user coming from IIS, eliminating the need for the 
ASPNET account.

Setting Description
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ek_dateFormat Enter a pattern describing how dates and times are stored in your 
database.

ek_workareaDateFormat Choose how you want to display dates in some areas of the 
Workarea.

• long - for example, Saturday May 21, 2005

• short - for example, 5/21/2005

ek_sitePath The location of Ektron CMS400.NET relative to the Web root. 
This value is set during installation at the Site Path Directory screen.
If you move Ektron CMS400.NET to another folder, you must 
update this value.

ek_buildNumber This value is set by the installation program. You typically would not 
change it.

ek_version This value is set by the installation program. You typically would not 
change it.

ek_appPath This element is prefixed by the ek_sitePath value and describes the 
location of the CMS400Workarea folder. This file stores external 
applications (such as eWebEditPro and eWebDiff), templates, and 
the images folder.

ek_xmlPath The location of the xmlfiles directory. The ek_sitePath path is 
prefixed to this location.
You would only change this value if you want to move the location of 
the xml files relative to the Web root.

ek_pluginDir not used currently -- for future use

ek_appName The name of the application, CMS400. You typically would not 
change this value.

ek_RedirectorInstalled Sets whether the redirector is turned on or off in the Ektron 
CMS400.NET  Workarea. Turning the redirector on enables the 
option of aliasing the URL of your Web site. The default is false.
True = Aliasing turned on
False = Aliasing turned off
See Also: The Administrator’s Manual section “URL Aliasing”.

Setting Description
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ek_RedirectorManualExt Set a comma-delimited list of Web page extensions for which you will 
want to create aliased pages. For example, ".aspx,.htm,.html,”. By 
default the list contains .aspx.

NOTE You can enter one or more extensions. Each extension must 
begin with a period, and the last extension must be followed by a 
comma (,).

See Also: The Administrator’s Manual section “URL Aliasing”.

String Values - These strings appear in Ektron CMS400.NET before the user logs in. They are placed 
here because this file is outside the database. Edit them if you want to translate them to another language 
or to make them more specific to your installation.

String Default Text

ek_String_1 Login

ek_String_2 Invalid username or password.

ek_String_3 Please try again.

ek_String_4 User:

ek_String_5 Pwd:

ek_String_6 Enter your username and password.

ek_String_7 Click here to close this window

ek_String_8 Click here to log in

ek_String_9 All the words

ek_String_10 Any of the words

ek_String_11 Exact Phrase

ek_String_12 Match Partial Words

ek_String_13 The search resulted in zero matches

ek_String_14 The following error occurred while trying to login:

Setting Description
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ek_String_15 Domain

ek_appImagePath The folder that stores the images within Ektron CMS400.NET , such 
as toolbar icons. You would only change this value if you need to 
move the images folder to another location.
Note that this value is prefixed by the value set in the ek_appPath 
variable. By default, ek_appPath is set to webroot/
CMS400Example/CMS400Workarea/. So, by default, this folder is set 
to webroot/CMS400Example/CMS400Workarea/images/
application/.

ek_appeWebPath The folder that stores eWebEditPro, Ektron CMS400.NET ’s editor. 
You would only change this value if you need to move the editor to 
another location.
Note that this value is prefixed by the value set in the 
ek_appeWebPath variable. By default, ek_appeWebPath is set to 
webroot/CMS400Example/CMS400Workarea/. So, by default, this 
folder is set to webroot/CMS400Example/CMS400Workarea/
ewebeditpro.

Images - Similar to text strings, these images appear before the user signs in, so cannot be stored in the 
database. Update as needed.
Their location is set in the ek_appImagePath variable. See Also: ”ek_appImagePath” on page 99

Setting Description

ek_Image_1
close button 

ek_Image_2
small login button 

ek_Image_3
big login button 

SMTP server configuration - See ”Configuring SMTP Settings” on page 109

Setting Description

ek_SMTPServer The server that processes email

ek_SMTPPort The port your system uses to retrieve email

ek_SMTPUser The username set up to send and receive email

Setting Description
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ek_SMTPPass The password set up to send and receive email

Mail Format

ek_MailFormat The format of the email created in Ektron CMS400.NET . A value of 
HTML generates email in HTML format, while a value of Text 
generates plain text email.

SSL Support - See ”Updating the web.config File” on page 116

ek_UseSSL Determines if server will use SSL for security

ek_SSL_Port SSL port used by Web server.

Active Directory Server Configuration

ek_ADEnabled Whether your Ektron CMS400.NET  uses Active Directory support.

ek_AUTH_Protocol The directory access protocol used with the Active Directory feature. 
The default value is LDAP. Other protocols are GC (global catalog) 
and WINNT.

Menu Settings

ek_UserMenuType Determines the appearance of the menu that appears within every 
content block after the user signs in.
0 - New dynamic menu - menu only appears when user moves 
cursor over content block
1 - Old classic menu - menu always appears
See Also: Ektron CMS400.NET  Administrator Manual section 
“Introduction to Ektron CMS400” > “Getting Started” > “Recognizing 
Content Blocks” > “The Floating Toolbar”

ek_MenuDisplayType
This setting only works if ek_UserMenuType is set to zero (0).

Determines the appearance of the menu that appears within every 
content block after the user signs in.
0 - Horizontal - menu icons are arranged horizontally
1- Vertical - menu icons are arranged vertically and include the 
tooltip text
See Also: Ektron CMS400.NET  Administrator Manual section 
“Introduction to Ektron CMS400” > “Getting Started” > “Recognizing 
Content Blocks” > “The Floating Toolbar”

Setting Description
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Multilingual Settings

ek_EnableMultilingual Enable or disable support for multilingual content
1- enable
0 -disable
See Also: Ektron CMS400.NET  Administrator Manual section 
“Multi-Language Support” > “Working with Multi-Language Content” 
> “Enabling/Disabling Support for Multiple Language Content”

ek_DefaultContentLanguage Sets the four-digit, decimal representation of the default content 
language. For example, American English is 1033.
If you have another version of an Ektron CMS (e.g., CMS200) or an 
earlier than 4.7 version of CMS400, all content blocks are set to this 
value during the upgrade.
See Also: See Also: Ektron CMS400.NET  Administrator Manual 
section “Multi-Language Support” > “Working with Multi-Language 
Content” > “The Default Language”

ek_ServerURL Mainly used in Web services to determine the location of a remote 
server.
For example, in a Web farm environment, the content server can 
reside in a remote location. In this case, the developer’s content is 
replaced with this value, so all <img src=””…/> and <href…. 
references point to server named here instead of the local one.

Miscellaneous Settings

WSPath Determines the location of the Web services page used by the server 
controls at design time.

ek_BatchSize The amount of files that can be uploaded at the same time. The 
default is 4, but it can be any non negative number.

Note: Users can upload any amount of files. The system handles 
them four at a time.

ek_loginAttempts Ektron CMS400.NET has a login security feature that, by default, 
locks out a user after five unsuccessful attempts to log in. That 
feature is controlled by this element.
For details, see the Ektron CMS400.NET  Administrator Manual 
section “Getting Started“> “Logging Into an Ektron CMS400.NET 
Web Site” > “Restricting Login Attempts.” 

Setting Description
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ek_passwordCaseSensitive By default, passwords are case insensitive. So for example, if the 
password is TOKEN and the user enters token, the signon is 
successful.
If you want to make passwords case sensitive, change the value of 
this element from false to true. 
If you do, and the password is TOKEN and the user enters token, the 
signon is unsuccessful. The user would have to enter TOKEN to sign 
on.

ek_LinkManagement This setting determines if Ektron CMS400.NET  uses linkit.aspx 
when inserting a quicklink. By default, it is set to true.
If set to true, when a user inserts a quicklink, Ektron CMS400.NET  
inserts a special link instead of a quicklink. A special link determines 
the correct quicklink to use when a site visitor clicks it.
For example, a user adds a content block to folder A. A quicklink to 
that content is a.aspx?id=10. Later, if an administrator changes the 
folder’s template but doesn’t update the quicklink within the content 
block, the quicklink is broken.
To avoid this problem, enable link management.

ek_LoginScreenWidth The width of the login screen in pixels. You may need to widen the 
screen if you are using Active Directory and the database names are 
long.

ek_ToolBarFormatTag
Note: This setting only applies after a user signs in to your site.

Change this setting if the colored border that surrounds content 
looks wrong. (The border color indicates the content’s status.)
By default, <table> tags create the border. If the border looks wrong 
or inappropriate, change setting to div. If you do, <div> tags are 
used to draw the border instead of <table> tags.
This change typically solves the problem.

Setting Description
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ek_PageSize This setting determines the maximum number of items that can 
appear on a page before it “breaks.” When a page breaks, additional 
entries appear on another screen, and the following text appears 
near the bottom of the items list:
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

Note: The above text changes depending on the page you are 
viewing.

You must click an option to see and update the remaining items.
This setting affects pages that let you edit the following items:

• content

• library items

• menu items

• collection items

• membership users

• membership users not verified

HttpHandlers This section sets how the URL Aliasing feature handles URLs with 
certain extensions. If you have any extension you do not want 
aliased, add it below the following line using the same syntax.
add verb="*" path="*.png" 
type="URLRewrite.StaticFileHandler,Ektron.Cms
.URLRewriter" />

maxRequestLength This setting determines the maximum size of files that can be 
uploaded to your server. The default setting is 204,800 kilobytes, or 
200 MB.
Enter the desired value in kilobytes. To convert megabytes to 
kilobytes, go to http://www.onlineconversion.com/computer.htm.

Setting Description

http://www.onlineconversion.com/computer.htm
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Configuring E-Mail  Notif ications 
for Tasks and Content Workflow

An email is sent to notify users when a task (such as approving a 
content block or submitting a form) was performed or needs to be 
performed. This section explains the steps needed to use 
Microsoft’s SMTP service to enable this kind of e-mail notification 
in Ektron CMS400.NET.

To learn about email notification for Web Alerts, see ”Installing the 
Web Alert Feature” on page 160.

CDOSYS
To process email, Ektron CMS400.NET uses the CDOSYS model. 
Using the Simple Mail Transport Protocol (SMTP) and the Network 
News Transfer Protocol (NNTP) standards, CDOSYS enables 
applications based on Windows XP, Windows 2000 or Windows 
2003 to route e-mail and USENET-style news posts across 
multiple platforms.

CDOSYS, the successor to CDONTS, is as easy to use as 
CDONTS but is more powerful by letting authors create and view 
sophisticated emails using html and data sources.

NOTE If the SMTP server that is processing email does not find CDOSYS installed, it 
tries to use CDONTS as a mail server protocol.

Set up SMTP Server
For CDOSYS to work, set up the SMTP server on your local 
system (to which you installed Ektron CMS400.NET) or a remote 
system that sends and receives email.
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NOTE To access an SMTP server on a local or remote system, consult the system 
administrator who manages email in your organization. This administrator may 
not be the same as the Ektron CMS400.NET administrator.

• Local - Before setting up an SMTP server on your local 
system, install IIS. The SMTP server settings on a local system 
would be something like this:

“ek_SMTPServer" value=“localhost”

“ek_SMTPServer" value=“127.0.0.1”

“ek_SMTPServer" value=“myname”

• Remote - Set up an SMTP server on a remote system. The 
SMTP server on a remote system can be something like this:

“ek_SMTPServer" value= “smtp.yourserver.com”

“ek_SMTPServer" value= “yourserver.com”

After the SMTP server is set up, configure it as described in 
”Verification for Relay” on page 105.

Verification for Relay
To verify that your Ektron CMS400.NET Web server’s IP address 
supports relay through your SMTP server, follow these steps.

NOTE The WWW and SMTP components of IIS must be installed on the Web server to 
which Ektron CMS400.NET is installed.
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1. On your SMTP server, access your Internet Services Manager 
in the Administrative Tools.

2. In the IIS Management Console, select the SMTP virtual 
server.

3. On the Action menu, click Properties.
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4. The SMTP properties window opens.

5. Click the Access tab.
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6. The access properties appear.

7. In the Relay Restrictions section, click the Relay... button.
8. The Relay Restrictions window opens. Set or remove relay 

restrictions.
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NOTE For more information, see “Setting or Removing Relay Restrictions from a Virtual 
Server” from this Web page: <http://www.microsoft.com/WINDOWS2000/en/
professional/help/moc04_57.htm>

Configuring SMTP Settings
Next, configure Ektron CMS400.NET to use SMTP.

1. Open the web.config file. (See ”Managing the web.config File” 
on page 95.)

2. Move to the section of the file that has these settings.
<!-- SMTP Server configuration -->

<add key="ek_SMTPServer" value="localhost" />

<add key="ek_SMTPPort" value="25" />

<add key="ek_SMTPUser" value="" />

<add key="ek_SMTPPass" value="" />

3. Set the ek_SMTPServer value. See ”Set up SMTP Server” on 
page 104.

http://www.microsoft.com/WINDOWS2000/en/professional/help/moc04_57.htm
http://www.microsoft.com/WINDOWS2000/en/professional/help/moc04_57.htm
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4. Set the ek_SMTPPort value to the port your system will access to 
retrieve email. In most cases, the port is set to 25. If that is not 
the case, see your System Administrator.

5. Set the ek_SMTPUser value to the username that is set up for the 
SMTP Server to send and receive email. Typically, the 
username takes the form of an email address, such as 
“ek_SMTPUser“ value=“yourname@companyname.com“.
This retrieval of email is based on how basic authentication is 
set up for you, though you do not need a username when using 
a local SMTP server. Check with your System Administrator for 
details.
If you are using a remote system for accessing email, you must 
provide an authenticated username before you can send or 
receive email. 

6. Set the "ek_SMTPPass" value to the password that is set up for 
the SMTP server to send and receive email. This password is 
based on the basic authentication. By default, the Ektron 
CMS400.NET only accepts passwords in the encrypted form.
To encrypt the password, Ektron provides a password 
encrypting tool. See ”The Encrypt Password Utility” on 
page 110.

The Encrypt Password Utility 
To use the utility tool EncryptEmailPassword.exe, follow these 
steps.

1. Open C:\Program Files\Ektron\CMS400\Utilities
2. Run EncryptEmailPassword.exe.
3. The Encrypt Utility dialog appears.
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4. Enter your SMTP password in the Text field.
5. Click the Encrypt button.
6. The screen displays an encrypted password in the Encrypted 

field.
7. Copy the encrypted password and paste it into the web.config 

file after "ek_SMTPPass" value=.

Error Messages
When submitting a form or a content block in an approval process, 
if you get an error message listed below, it is generated by the 
SMTP server on which you set up the mail system, not by Ektron 
CMS400.NET.

• The Transport failed to connect to the server. [CBR 
SendMail R1] [CBR R65] [DIO R 36]

• The server rejected one or more recipient addresses. The 
server response was: 550 5.7.1 Unable to replay for 
yourname@company.com [CBR SendMail R1] [CBR R1] 
[DIO R36]
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What’s Next?
After you set up the mail server, you can begin using Ektron 
CMS400.NET. For e-mail notification to work properly in Ektron 
CMS400.NET, the following criteria must be met.

• Valid system email address

• Email notification is enabled in the settings table

• Valid user email address

• User email notification is enabled

For information about these settings, refer to the Administrator 
Manual.
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Configuring SSL

In Ektron CMS400.NET, you can use SSL when users log in to your 
Web site. SSL encrypts the username and password during 
transmissions to the server.

When you set up the SSL certificate, and configure Ektron 
CMS400.NET to use it, the login page is launched in a Secure 
Socket Layer. This section explains how to set up SSL for Ektron 
CMS400.NET.

Setting Up the Certificate
If your Web server does not have a certificate installed, you need 
to install one. To do so, follow these steps.

1. Access the Internet Information Server Administrator Console 
on your Web server.

2. Navigate to the computer and Web site to which Ektron 
CMS400.NET is installed.

3. Right click on the Web site.
4. Click Properties.
5. Click the Directory Security tab.
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6. In the Secure communications area, click the Server 
Certificate button.
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7. Use the wizard to set up a certificate for your Web site.
8. Close the wizard. You return to the Properties window.
9. Click the Web Site tab at the top of the Properties window.
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10. Set the SSL Port that the Web server will use.
11. Click OK.

Updating the web.config File
Next, configure Ektron CMS400.NET to use the SSL certificate.

1. Open the web.config file. (See ”Managing the web.config File” 
on page 95.)

2. Move to the section of the file that has these settings.

<add key="ek_UseSSL" value="false" />

<add key="ek_SSL_Port" value="443" />

3. Set the ek_UseSSL value to true.
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WARNING! If the ek_UseSSL value is true, but you did not install the certificate to the Web 
Server, you cannot log into Ektron CMS400.NET.

4. Set the ek_SSL_Port value to 443 (unless you specified another 
SSL port).

5. Save and close the file.
You are ready to use the SSL support for Ektron CMS400.NET.
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Customizing Ektron CMS400.NET

The following chapter contains information about customizing your 
Ektron CMS400.NET application. The topics that are discussed are:

• ”Customizing Ektron CMS400.NET email” on page 119

• ”Branding Ektron CMS400.NET” on page 124
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Customizing Ektron CMS400.NET 
email

Introduction
Ektron CMS400.NET can send email notification to users, 
informing them that actions have either taken place or are 
requested of them. For example, a content contributor receives an 
email that his content has been published to the Web site.

These emails are stored in and received from the app_messages 
table in the database. In that table, each email consists of one 
string for the subject and one for the body. Ektron CMS400.NET 
does not currently support HTML emails, however the messages 
are fully customizable.

The body of an email often includes variables, which are between 
the @ symbols. Ektron CMS400.NET replaces these variables on 
the fly with the information for that instance of the email. For 
example, @appContentTitle@ in the following sentence is replaced 
with the email’s title. 

These emails can be customized. The variables can be taken out 
or moved around. More text can be added; text can be rewritten or 
reorganized. 

Each message is called in the presentation layer by its message 
title. 

Before The content “@appContentTitle@” has been deleted.

After The content “Home Page Content” has been deleted.

Before  “@appContentTitle@” has been deleted from the XYZ Web site.

After “About Us” has been deleted from the XYZ Web site. 
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Carriage Return/Line Feeds are represented by the variable 
@appCRLF@. These cause the email to move down one line. For 
example: 

Variables
The following table lists variables you can use to customize email 
messages. When the email is sent, the corresponding description 
replaces the variable.

Before The content was approved.@appCRLF@Thank you!

After The content was approved.
Thank you!

Variable Inserts

@appCRLF@ A carriage return.

@appContentTitle@ The title of the content block.

@appDeletionDateTime@ The date and time the content will be deleted from the Web site.

@appChangeDateTime@ The date and time changes will be updated on the Web site.

@appDeclinerFirstName@ The first name of the user who declined the content block.

@appDeclinerLastName@ The last name of the user who declined the content block.

@appSubmitterFirstName@ The first name of the user who submitted the content block.

@appSubmitterLastName@ The last name of the user who submitted the content block.

@appFolderPath@ The location of the content block in the folder tree in the Ektron 
CMS400.NET Workarea.

@appContentLink@ The link to the content block on the Web site.

Note: You must be logged in to see the changes.
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List of Ektron CMS400.NET email

Notify Approval Process Complete
Because of the logic, there are four emails for notifying that the 
approval process is complete.

Deletion of Content Approved

Message Title: email subject: content deletion approved.

Message Text: Deletion of content has been approved.

Message Title: email body: content deletion approved.

Message Text: The deletion of the content “@appContentTitle@” 
has been approved. The content deletion will occur on: 
@appDeletionDateTime@. 

Immediate Deletion of Content

Message Title: email subject: content has been deleted.

Message Text: Content has been deleted.

Message Title: email body: content has been deleted.

Message Text: The deletion of the content “@appContentTitle@” 
has been approved. The content was deleted immediately. 

Approved Content Awaiting Go Live Date

Message Title: email subject: content changes approved.

@appSubmitterDateTime@ The date and time the content block was submitted.

@appApprovalList@ The current approval list that the content block must pass through.

@AppComment@ Displays the comments for the content block.

Variable Inserts
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Message Text: Content changes have been approved.

Message Title: email body: content changes approved.

Message Text: The changes to the content “@appContentTitle@” 
have been approved. The content changes will occur on: 
@appChangeDateTime@.

Approved Content Published Immediately

Message Title: email subject: content has been changed.

Message Text: Content changes have been made.

Message Title: email body: content has been changed.

Message Text: The changes to the content “@appContentTitle@” 
have been approved. The content changes went live immediately.    

Decline Approval Request
Message Title: email subject: approval request declined.

Message Text: Content approval request declined.

Message Title: email body: approval request declined.

Message Text: Your submitted approval request for the content 
“@appContentTitle@” has been declined by 
“@appDeclinerFirstName@ @appDeclinerLastName@”.

Send Approval Message
Message Title: email subject: request for approval.

Message Text: Request for content approval.

Message Title: email body: request for approval.

Message Text: The content “@appContentTitle@” has been 
submitted for your approval by “@appSubmitterFirstName@ 
@appSubmitterLastName@”.@appCRLF@@appCRLF@To locate 
the content, the folder path in your workarea is: 
@appFolderPath@.@appCRLF@@appCRLF@The following link will 
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take you to the submitted content block on the Web site: 
@appContentLink@.@appCRLF@@appCRLF@Please Note: You 
must login and select the preview icon to view the 
changes.@appCRLF@@appCRLF@The content was submitted for 
approval on: 
@appSubmittedDateTime@.@appCRLF@@appCRLF@Approvals: 
@appApprovalList@@appCRLF@@appCRLF@Comment: 
@appComment@.
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Branding Ektron CMS400.NET

Ektron CMS400.NET can be branded by a Web Developer. 
Through the use of a style sheet and replacing Ektron 
CMS400.NET’s default graphics, the application can take on a 
different look that is fully customizable. Developers can incorporate 
a company logo, institute company colors, and control the look and 
feel of the application to create a personalized, web-based, 
content management solution.

Style Sheet
Ektron CMS400.NET’s style sheet, global.css, is located in the /
csslib folder under the Workarea directory. 

Using widely accepted style sheet classes and class attributes, 
you can modify the application, including colors, spacing, fonts, 
etc. Also, if you later upgrade or re-install Ektron CMS400.NET, you 
can reuse this file and retain your changes.
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Class Explanation
General Classes

Workarea Classes

Class Description

.titlebar Located at the top of every page in the application, this class is 
used for page explanations or location explanation. While 
navigating through Ektron CMS400.NET, this page header or 
“titlebar” tells the user where he is (for example, Viewing content 
in content.asp).

.titlebar-error Very similar to titlebar, this class is used to display error 
messages.

.input-box-text In front every input box is text explaining its purpose. This class 
controls that text.

.title-header Used under the titlebar when information is going to be listed. 
For example, it is used for column headers.

.info Any important information that should stand out gets the info 
class. An example of this class can be seen in the content page 
when showing the attributes of the content block.

.info-header  Very similar to the info class, this is used for information that 
should stand out but starts a new section on a page. An example 
is the word “metadata” or “summary” on the content block 
properties page

.toolbar The background of the toolbar.

Note: Only change this class if you are changing all toolbar 
icons.

Class Description

.workarea The background color of the workarea.

td.FolderButtonBarNm Text of top-level folders that appear in the lower left corner of the 
Workarea (Content, Forms, Library, Modules and Settings)
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td.FolderButtonBarOver Text that appears when you hover the cursor over top-level 
folders that appear in the lower left corner of the Workarea 
(Content, Forms, Library, Modules and Settings)

td.FolderButtonBarSelectedOver Selected text in the lower left corner of the Workarea (Content, 
Forms, Library, Modules and Settings)

td.FolderButtonBarSelected Text that appears when you hover cursor over selected text of 
top-level folders that appear in the lower left corner of the 
Workarea (Content, Forms, Library, Modules and Settings)

td.FolderResizeBar The bar at the top of the top-level folders that appear in the lower 
left corner of the Workarea (Content, Forms, Library, Modules 
and Settings). Use this bar to switch the display of folders 
between icons and full buttons.

td.NavIconBarNm Defines the minimized top level folder icons properties.
The following example shows, the minimized icons with a brown 
background.

td.NavIconBarOver Defines the minimized top level folder icons hover over 
properties.
The following example shows, the Forms icon with an light 
orange background, while hovering over it.

td.NavIconBarSelectedOver Defines properties of the minimized top level folder icons when 
selected then hovered over.
The following example shows, the Forms icon with a dark blue 
background, while selected and hovering over it.

Class Description
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td.NavIconBarSelected Defines the minimized top level folder icons properties, when 
selected.
The following example shows, the Forms icon with a green 
background when selected.

body.FolderIconBar The bottom bar the minimized top level folder icons appear in.
The following example shows the bar green.

table.FolderToolbar The top left bar where the Smart Desktop and pin buttons are 
located.
The following example shows the bar red.

Class Description
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body.FolderArea Defines the folder area on the left of the screen.
The following is an example of a green background with red 
scrollbars.

.WorkareaToolbar-nm Defines the workarea toolbar properties for the buttons section.
the following is an example of a red background.

.WorkareaToolbar-ovr Defines the workarea toolbar icon hover over properties.
The following is an example of View Collections background 
being green when hovered over.

Class Description
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.ToolbarImage-nm Sets the size of the workarea toolbar icons.
The following is an example of setting the height and width to 
35px.

The following example has the height and width set to default 
22px.

.WorkareaToolbar-bk Defines the workarea toolbar properties for the non-button 
section.
The following is an example of a red background.

.WorkareaTitlebar Sets the properties of the titlebar in the workarea.
The following example show a red background with black letters.

Class Description
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body.UiMain Defines the properties of the user interface area.
The following example shows a green background with a red 
scrollbar.

TD Defines the default fonts in the logo bar area, the toolbar area, 
the folder buttons, and user interface area.
In the following example, the font is green.

Class Description



Customizing Ektron CMS400.NET

Ektron CMS400.NET Setup Manual,  Version 5.5 for .NET 2.0 Revision 1 131

A Defines properties of links in the workarea, before the links have 
been selected.
The following example shows the links in green.

A:ACTIVE Defines properties for links currently active.
The following example shows the active link red.

A:Visited Defines properties for links visited.
The following example shows the visited links in navy blue.

Class Description
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TD.titlebar-error Defines error display properties.
The following example shows the error displayed with a silver 
background and red font.

TD.input-box-text Defines the properties of the text that appears before a text box.
The following example shows the text color purple.

TD.title-header
TR.title-header

Defines the column head properties in the workarea.
The following example shows the column head backgrounds in 
green.

Class Description
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A.title-header Defines the font properties in the column heads.
The following example shows the column heads with green 
fonts.

TD.info Defines description information title properties.
the following example shows the information titles in purple.

TD.info-header Defines the information header label.
The following is an example of the information header in green.

Class Description
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.moreinfo Defines the font used on the Smart Desktop in the workarea.
The following example shows the font in green.

td.tab_actived Defines the active tab properties in the work area.
The following example shows the active tab with a green font.

td.tab_disabled Defines the non-active tab properties in the work area.
The following example shows the non-active tabs with a dark 
blue font and blue background

Class Description
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td.tab_last Defines the properties of the space at the end of the tabs.
The following example shows the space at the end of the tabs 
with a green background.

td.tab_spacer Defines the properties of the space between the tabs.
The following example shows the spaces as green.

Class Description
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History Classes

Login Classes

Folder Control Classes

Library Classes

Calendar Classes

The calendar uses the calendar.css style sheet, which is installed 
by default to the Web root directory.

Class Description

.history-list This class is used for two attributes. The TD controls the active date or 
the version that is presently published. The Anchor class is for the other 
versions of the content block.

Class Controls

.login The background color of the login and logout screen.

Class Controls

.folder The font attributes of the folder control.

NOTE: The font size cannot be controlled by the style sheet. It is set by 
the browser.

Class Controls

.library The background color of the three panels in the library.



Customizing Ektron CMS400.NET

Ektron CMS400.NET Setup Manual,  Version 5.5 for .NET 2.0 Revision 1 137

Images
Application Images

To change the look Ektron CMS400.NET via a logo, you must 
change two images.

• workarea_logo.gif - the logo of the application. It presently 
displays the Ektron CMS400.NET logo. It lives under 
\CMS400Workarea\images\application directory. 
By changing this image, the application can be branded to 
display any other graphic or logo. You must use the same size 
attributes of 155 pixels wide by 77 pixels high. Alternate size 
attributes will cause the application to look wrong.

• navigation_edit.gif. This also resides in the application folder. 
This image is used for the left bar in the edit content, edit 
metadata, edit summary, and add content work areas. This 
image can also be changed but must retain the same size 
attributes of 128 pixels wide by 500 pixels high.

A third image, workarea_back.gif, makes up the blue/gray 
background at the top of the workarea. The size attributes are 50 
pixels wide by 77 pixels high. This image cannot be less than 50 
pixels wide as Netscape and Firefox do not repeat it correctly.

Language Images

Several language specific Images are used at the top of the 
workarea. They reside in the language folders and always start 
with the word “workarea” and end with “_top.” 

These images are 467 pixels wide by 77 pixels high. Their width 
can change but the height cannot. 

There are approximately six images in each language folder. an 
Adobe Photoshop file, workarea_top.psd, can be found under 
\CMS400Workarea\images\English folder. You can modify these 
images as needed.
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Converting CMS300 to Ektron 
CMS400.NET

Many customers who purchase Ektron CMS400.NET are upgrading 
from Ektron CMS300. Converting Ektron CMS300 to Ektron 
CMS400.NET is explained in the following sections:

• ”Step 1: Back Up Your Site and Database” on page 138

• ”Step 2: Install New Ektron CMS400.NET” on page 139

• ”Step 3: Migrate Your CMS300 Database For Use with Ektron 
CMS400.NET” on page 140

• ”Step 4: Copy Folders and Files” on page 142

• ”Step 5: Set Folder Permissions” on page 142

• ”Step 6: Update Files” on page 143

• ”Step 7: Create an IIS Application For Your Site” on page 146

• ”Step 8: Add Ektron CMS400.NET License Keys” on page 149

• ”Step 9: Verify Installation” on page 150

NOTE For more information on upgrading your site to Ektron CMS400.NET, see 
”Migrating Your Site to Ektron CMS400.NET” on page 151.

Step 1: Back Up Your Site and Database
Before starting any migration or upgrade process, you should 
always back up your site and database.

Best Practices
Ektron recommends running the migration procedure on a separate 
copy of the production database or in a staging/development 
environment.
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WARNING! This is a very important step! It should not be skipped! If you do not back up your 
database and convert to Ektron CMS400.NET , you will not have a way to go 
back to using your database in CMS300 if there is a problem. Also, there are file 
changes that need to be made. If you do not back up your site, you will have to 
undo each change manually.

Backing Up Your Site
You can back up your site files as you would any other group of 
files. You can copy them to a different location or use software to 
back them up to a tape drive or CD.

Backing Up Your Database
The steps for performing a backup on a Microsoft SQL database 
are explained in ”Backing Up Databases” on page 22. If you have 
another type of database, such as mySQL, Oracle or Access, you 
can use the backup procedures provided with the software.

Step 2: Install New Ektron CMS400.NET
Install the latest version of Ektron CMS400.NET with platform 
support. This procedure is explained in ”Installing Ektron 
CMS400.NET” on page 41.

As explained in ”Performing the Installation” on page 41, the 
installation involves copying files to your server then setting up a 
sample site. While setting up the site, follow these instructions.

• When asked to insert your license keys, ignore the screen. 
(You will insert your license keys in ”Step 8: Add Ektron 
CMS400.NET License Keys” on page 149.)

• When asked to choose a site type, select Minimal.
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• Say no to the database install. You will upgrade the CMS300 
database for use with CMS400.

Step 3: Migrate Your CMS300 Database For Use 
with Ektron CMS400.NET

NOTE Ektron CMS400.NET requires a physical installation of the product. If you do not 
have physical access to the machine, someone with access to the machine must 
run the install. For more information, see ”Installing Ektron CMS400.NET” on 
page 41.

Your database must satisfy the following criteria before you can 
use it with Ektron CMS400.NET. It needs to

• be a Microsoft SQL database

• be the same CMS version

• have ASPNET or IIS_WPG (if you are using Microsoft 
Windows 2003) user access to your database if you are using a 
trusted connection

This should be done in the following order.

1. ”Migrate Database to Microsoft SQL” on page 141.
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2. ”Upgrade Database to Ektron CMS400.NET” on page 142.
3. ”Adding Database Permission for ASPNET or IIS_WPG users” 

on page 142.
The following image shows the database migration path. This 
example uses CMS300 v4.2 going to the latest Ektron 
CMS400.NET version.

Migrate Database to Microsoft SQL
You must migrate your database in the same CMS it currently 
resides in. For example, if you are using CMS300 and have an 
Oracle database, you need to upgrade to Microsoft SQL in 
CMS300. You can migrate your database to Microsoft SQL from 
the following programs:

• Microsoft Access

• Oracle

• MySQL
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You can migrate your database to Microsoft SQL by using the 
Database Mover program. To do this, click Start > Programs > 
Ektron > CMS300 > Utilities > Database Mover.

Upgrade Database to Ektron CMS400.NET
Upgrade your Microsoft SQL database from Ektron CMS300 to 
Ektron CMS400.NET. If your Ektron CMS300 version number 
matches the Ektron CMS400.NET version number, you do not 
need to perform this step.

To upgrade, use the Database Upgrade program installed with 
Ektron CMS400.NET. To do this, click Start > Programs > Ektron 
> CMS400 > Utilities > Database Upgrade.

Adding Database Permission for ASPNET or IIS_WPG users
After upgrading the database to the latest version of Ektron 
CMS400.NET, you need to add permission for either the ASPNET 
or IIS_WPG users to the database. Use the ASPNET user if you 
are using a Microsoft Windows 2000 or Windows XP Professional 
Server. Use the IIS_WPG user if you are using a Microsoft 
Windows 2003 Server.

Step 4: Copy Folders and Files
Copy the following folders and files to your CMS300 site webroot. 
For example, if you installed the CMS400min site and are using the 
CMS300Sample site as your site, copy the folders and files from 
the CMS400min site to C:\Inetpub\wwwroot\CMS300Sample.

• The C:\inetpub\wwwroot\cms400min\workarea folder, including all 
subfolders

• The C:\inetpub\wwwroot\cms400min\bin folder

• C:\inetpub\wwwroot\cms400min\web.config

Step 5: Set Folder Permissions
The following folders in the site root need to have either the 
ASPNET user or IIS_WPG user added with Read, Write and 
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Modify permissions. The IIS_WPG user is for Microsoft Windows 
Server 2003 only.

The table below contains Folder, User and Permission settings 
information.

Step 6: Update Files
The following files have information in them that need to be 
updated.

• ”Web.config” on page 144 - Everyone needs to update this file.

• ”site_scripts_path.asp” on page 144 - need updating if you are 
using ASP pages.

• ”applicationAPI.asp” on page 144 - need updating if you are 
using ASP pages.

• ”site_scripts_path.php” on page 145 - need updating if you are 
using PHP pages.

• ”applicationAPI.php” on page 145 - need updating if you are 
using PHP pages.

• ”PHP Templates” on page 146 - need updating if you are using 
PHP pages.

• ”Application.cfm” on page 146 - needs to be completed if you 
are using ColdFusion pages.

Folder User Permission

uploaded images ASPNET User or
IIS_WPG (Windows 
Server 2003 only)

• Read

• Write

• Modify

uploadedfiles ASPNET User or
IIS_WPG (Windows 
Server 2003 only)

• Read

• Write

• Modify
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Web.config
The settings in the web.config file equate to the settings in the 
CMS300 setup.xxx files. Update the following Web.config file 
settings to reflect your current database, site location, and WSpath.

site_scripts_path.asp
Update the path to the applicationAPI.asp file. For example:

<!-- #include virtual=”/cms300sample/cms300scripts/applicationAPI.asp” -->

becomes

<!-- #include virtual=”/cms300sample/Workarea/platforms/asp/
applicationAPI.asp” -->

applicationAPI.asp
Update the WSDLpath to new location of your Web services file. 
Update the CMS400 Workarea to the new location of the Workarea 
folder. For example:

WSDLpath = "http://localhost/CMS400Example/WorkArea/WebServices/
ContentWS.asmx"

Setting How to Change

ek_dbCatalog Change to the name of your CMS300 database

ek_dbUserName Add the user name for your CMS300 database

ek_dbPassword Add the password for your CMS300 database

ek_sitepath Change the site path to your site’s webroot. For 
example: /CMS300Sample/

WSpath Change the web service path. For example:
http://localhost/CMS400min/Workarea/
ServerControlWS.asmx

Becomes
http://localhost/CMS300sample/Workarea/
ServerControlWS.asmx
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becomes

WSDLpath = "http://www.MyEktronSite.com/WorkArea/WebServices/
ContentWS.asmx"

and

CMS400WorkareaPath = "/CMS400Example/WorkArea/"

becomes

CMS400WorkareaPath = "/www.MyEktronSite.com/WorkArea/"

site_scripts_path.php
Update the path to the applicationAPI.php file. For example:

<?php  include_once ‘cms300scripts\applicationAPI.php’; ?>

becomes

<?php  #include_once ‘Workarea\platforms\asp\applicationAPI.php’; ?>

applicationAPI.php
Update the WSDLpath to new location of your Web services file. 
Update the CMS400 Workarea to the new location of the Workarea 
folder. For example:

$WSDLpath = "http://localhost/CMS400Example/WorkArea/WebServices/
ContentWS.asmx?WSDL";

becomes

$WSDLpath = "http://www.MyEktronSite.com/WorkArea/WebServices/
ContentWS.asmx?WSDL"

and

$CMS400WorkareaPath = "/CMS400Example/WorkArea/";

becomes

$CMS400WorkareaPath = "/www.MyEktronSite.com/WorkArea/";
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PHP Templates
When upgrading your Ektron CMS300 to Ektron CMS400.NET, 
add the following line between the head tags for each template.

IMPORTANT! This only needs to be done if you are upgrading from CMS300 to CMS400.NET

<meta http-equiv="Content-type" content="text/html; charset=utf-8" />

Application.cfm
Copy the settings in the 
\workarea\platforms\coldfusion\application.cfm file into 
the application.cfm file in the root of your site. These settings 
supersede and replace current CMS300 settings and includes.

Alter the application.wsdlpath and application.workarea 
values inside the application.cfm file to reflect the correct URL 
of your CMS site.

Step 7: Create an IIS Application For Your Site
Perform this only if your site is not in your server’s webroot, or if 
your Web site is not already set up as an IIS application

Ektron CMS400.NET must be an IIS application to run properly.

To see if your Web site is running as an IIS application, go to your 
server’s Computer Management Console and view the Internet 
Information Services section. Use the following table to determine 
if your Web site is running as an IIS application.

Microsoft 
Windows 
Version

Icon Next to 
Your Site 
Name In IIS

Web Site running 
as an IIS 
Application?

2003 Server Yes

XP Professional Yes
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If an IIS application needs to be created for your Web site, follow 
these steps.

1. Click Start > Control Panel > Administrative Tools > 
Console Management

2. In the left pane of the console, click Services and 
Applications > Internet Information Services > Web Sites > 
Default Web Site

Any No

Microsoft 
Windows 
Version

Icon Next to 
Your Site 
Name In IIS

Web Site running 
as an IIS 
Application?
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3. Right click your Web site and select properties.
The following window appears.

4. Click the Create button
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5. Your site is now an IIS application

6. Click OK.

Step 8: Add Ektron CMS400.NET License Keys
You need to add your CMS400 license keys to the database. You 
can use the builtin account to accomplish this. The builtin 
account’s username is builtin and password is builtin.

WARNING! You should only use the builtin account temporarily. As soon as possible, insert 
the license key and log in under a user name assigned in Ektron CMS400.NET.

Below are the steps for adding license keys to Ektron CMS400.NET.

1. Navigate to your Web site’s Ektron CMS400.NET login page.
2. Click Login.
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3. Use the username builtin and the password builtin.
4. Click Workarea.
5. Click Settings > Configuration > Setup.

6. Click the Edit button ( ).
7. Insert your license key and any module keys.

8. Click the Update button ( ).

Step 9: Verify Installation
When first attempting to use the platform support, you may get a 
timeout message as the Web services bridge is established for the 
first time. If this occurs, wait several seconds and then refresh the 
page or navigate to another page. Once the connection is 
established, you will notice a speed improvement over the old 
platform support in CMS300.
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Migrating Your Site to Ektron 
CMS400.NET

This chapter explains how to migrate your Web site to Ektron 
CMS400.NET. This chapter explains 

• What to copy to your Web site

• Setting up and deploying templates

This chapter assumes you installed Ektron CMS400.NET and have 
read the Ektron CMS400.NET Administrator Manual so that you 
have an understanding of basic concepts, some of which are 
mentioned here.

Initial Steps
The following section describes tasks you need to perform before 
migrating your Web site.

Installation
Ektron CMS400.NET requires a physical installation of the product. 
If you do not have physical access to the machine, someone with 
access to the machine must run the install.

For more information, see ”Installing Ektron CMS400.NET” on page 41.

Verify Installation
After you install Ektron CMS400.NET, verify that it is properly 
installed by using the sample site. By default, the sample Web site 
is located at the following address on the machine to which Ektron 
CMS400.NET is installed.

http://localhost/CMS400Example/default.aspx
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If you can browse the sample site and it works properly, Ektron 
CMS400.NET is properly installed.

Setting up Your New Site
NOTE You can use the Site Setup utility to perform these tasks. To launch this utility, go 

to Start > Programs > Ektron > CMS400 > Utilities > Site Setup. To read about 
it, go to ”Setting up a Site” on page 48.

Copy Application Core Files
Copy the application core files from the CMS400Example/workarea 
folder into your site’s folder. These files operate the workarea, 
library, and content functions.

Set up the Database
Since the content is stored in a database, you need to create one. 
To learn how to set up a database, see ”Setting up a Database” on 
page 52.

Modify Application Parameters
After you install and create the Ektron CMS400.NET database, 
modify the web.config file that installed to the directory to which 
you installed Ektron CMS400.NET.

Edit that file and modify the following settings

Best Practices
Ektron recommends keeping a working version of the sample site. This 
can be used to help you debug problems.
For instance, if you encounter errors on your site, you can refer to the 
sample site to see if the same errors occur. If they do, that may indicate 
a problem with the installation. If they do not, the installation is probably 
OK and an external factor is causing the problem.

Setting Type in...

ek_dbDatabase The type of database you are using. 
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NOTE If you are using SSL, the settings you need to modify are explained in ”SSL 
Support” on page 31.

Creating a Login Page
Now that everything is set up, you can create a login page. You 
can either copy the one from the sample site or create your own.

A list of the content tags can be found in the Ektron CMS400.NET 
Developer’s Reference Manual.

Log In
To log into your Ektron CMS400.NET Web site, follow these steps.

1. Browse to the login page you created and click the Login 
button.

2. A login dialog box opens asking for a username and password.
3. Enter the default username (admin) and password (admin) 

and click Login.
4. You are logged into Ektron CMS400.NET

NOTE If you get a message that the application is locked, log in using the username and 
password builtin/builtin. You get the message if your license key is invalid or has 
not been entered yet.

Modifying Configuration Settings
After you log in, access the Workarea by clicking on the Workarea 
button. From there, you can modify the configuration settings.

ek_dbUsername/
ek_dbPassword

The username and password, if your database 
requires one.

ek_sitePath The relative path from Web root to the scripts 
folder.

Setting Type in...
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Set up Active Directory
If plan to use Active Directory, configure this now. The settings for 
Active Directory can be found in the Settings > Configuration 
folder. Refer to “Active Directory Integration” in the Administrator 
Manual.

Modify the Setup Screen
The Ektron CMS400.NET setup section is located under the 
Settings > Configuration folder. The setup section allows you to 
configure items such as your license key, style sheet support, max 
content size, and default language.

See 'Configuring Ektron CMS400” in the Administrator manual for 
more information.

Set up Metadata
Ektron CMS400.NET includes extensive metadata support. 
Settings for metadata definitions can be found under the Settings 
> Configuration folder in the Workarea. You can have as many 
metadata definitions as needed.

See “Metadata” in the Administrator manual for more information.

Set up XML Configurations
You can also set up your XML configurations. You create XML files 
externally or via the Data Designer. Next, an XML configuration is 
assigned to content blocks and folders.

See “Managing XML” in the Ektron CMS400.NET Administrator 
Manual for additional information.

Creating Ektron CMS400.NET Users
If you are not using Active Directory support, add your users 
manually. The maximum number of users is determined by your 
license key. For instance, if you purchase a 10-user license, you 
can enter 10 users.
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NOTE If you exceed the licensed number of users, you may get locked out of Ektron 
CMS400.NET. 

Every user must belong to a group. When you first add a user, he 
or she is automatically added to the Everyone group. You can 
create more user groups and add users to them as desired.

For more information, see “Managing Users & User Groups” in the 
Administrator manual.

Configuring Content and Forms Folders
Next, create folders to organize content blocks and forms. Create 
as many folders as you want. Each folder level can go as deep as 
you want.

As you create folders, you can assign a default template and style 
sheet. The default template is used when a new content block is 
created and Ektron CMS400.NET creates a Quicklink that points to 
the new content block. If you do not provide a default template, it is 
inherited from the parent folder.

After creating the folders, assign permissions and workflow to 
them. Permissions can be assigned to a user or a user group. The 
same is true for the approval process.

Best Practices
Keep your folder structure simple so it’s easy for your users to 
navigate. Organize folders in a way that makes sense to the users who 
will navigate through them. So, you may have 6 or so top level folders, 
and each folder may go 4 or so deep.
This folder structure is replicated under the Library folder.

Best Practices
Limit permissions for the “Everyone” group, as this gives every user 
permissions to that content. Similarly, you should limit the “Everyone” 
group’s inclusion in the approval chain if you want to restrict which 
users can publish content.
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Creating your Templates
Now you can create your templates. Templates contain the look 
and feel of the site. Masthead, navigation, and footer graphics are 
all part of the template. Use server controls to insert Ektron 
CMS400.NET content into a template. A list of server controls is in 
the Developer’s Manual.

You can add as many server controls per template as you want, 
but you can only have one dynamic tag per template.

Migrating/Creating Content
At this point, you can begin to create/migrate your content. If you 
are migrating content from an existing site, add a new content 
block, and cut and paste the content into the Ektron CMS400.NET 
editor.

NOTE All images and files must be uploaded and inserted into the content separately. 

Deployment
Deployment from development to production is as simple as 
moving the files over. To properly deploy your new Ektron 
CMS400.NET Web site, following these steps.

1. Copy all assets (templates, images, files, etc.) from your 
development box to your production machine.

2. Move the database. You have two choices 

• point your data source on the production machine to the 
database you were using

Best Practices
Since dynamic templates include URL parameters, make each main 
landing page and other important pages static tags. This makes it 
easier for you to remember if you need to provide that link to someone.
For instance, each main landing page from your home page could use 
the static tag. Then, as you go deeper into that section, subsequent 
pages use a dynamic tag.
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• copy the database, move it to your production box, and point a 
data source to that

Advanced Features
The previous information allows you to create a basic Ektron 
CMS400.NET Web site from scratch. This section explains some 
advanced features that you may implement, although they are not 
needed for the Web site to function properly.

Email Notification
For email notification to work in Ektron CMS400.NET, make sure 
the SMTP service is setup and running in IIS, and that it points to a 
valid mail server.

Refer to ”Configuring E-Mail Notifications for Tasks and Content 
Workflow” on page 104 for additional information.

Other
Other items, such as Load Balancing, can be configured in Ektron 
CMS400.NET. Please see the special features section of the 
Administrator Manual for more information. 
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Moving Content from Staging to 
Production Server

Best Practice: Site Replication
To move content from a staging server to a production server, use 
Ektron’s Site Replication Feature. Site Replication is an 
automated, one-way site synchronization between a staging or test 
server and a production server. It lets you perfect the changes on 
the staging server, then effortlessly copy them to the production 
server. In this way, your production server can easily be kept up to 
date, while at the same time be spared simple errors that typically 
accompany last-minute changes.

Site Replication is described in the Ektron CMS400.NET 
Administrator Manual section “Site Replication.”

Separate Staging and Production Servers
Ektron CMS400.NET also supports the traditional model of separate 
staging and production servers. If you choose not to purchase the 
Site Replication Feature, the next best strategy uses both a virtual 
and a physical staging server.

• Use a virtual staging server for the majority of your Web 
updates. Ektron takes this approach with its site, 
www.ektron.com.
A virtual staging server lets authors work directly on a 
production server yet prevents site visitors from viewing 
modifications until they are approved. Here’s how it works. An 
author edits content and submits it for approval. Authorized 
reviewers preview the changes and decide to publish or reject 
them. Reviewers can also edit the content then publish. All of 
this can occur on a single server, which acts as a virtual staging 
and a production server.
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• When the Web site undergoes a significant architectural 
change, use a physical staging server. An example of such a 
change would be one or more new templates. 

The procedure for copying your site from a staging to a 
production server is described in ”Moving a Site to Another 
Directory or Server” on page 86.

.

Best Practices
Ektron recommends setting up the staging server with the same site 
path that the production server uses. This keeps references to library 
items that include site paths intact when the site is moved from staging 
to production server.
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Instal l ing the Web Alert  Feature

The Web Alert feature enables Ektron CMS400.NET to generate 
email for a list of registered users whenever new content appears 
on your site, or existing content is updated.

For example, anyone may register to be notified whenever new 
information about your product is published. As soon as the page 
is published on your site, registered users receive an email 
announcement with a link to the new/updated page. The recipient 
clicks the link and immediately accesses the page.

As a result, a self-selected group of users can be instantly notified 
of changes on your Web site relating to their interests. Once the 
system is set up, you don’t need to do anything -- everything 
happens in the background.

This section describes how to install the Web Alert feature. For 
additional information about setting up and using the feature, see 
the Ektron CMS400.NET Administrator manual section “Web Alert 
Feature.”

Server Configuration
The following illustration depicts a typical Web server configuration 
you would use with the Web Alerts feature.
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• Firewall - the Ektron CMS400.NET business tier must have 
Web access to the asynchronous server. The business tier 
maintains the CMS files. This configuration enables proper 
communication between Ektron CMS400.NET and the 
asynchronous processor.

- The asynchronous processor must have port 25 (SMTP) 
access to a valid mail server to send emails

- The mail server (omitted from the illustration) must be 
allowed to send out port 25 (SMTP) traffic and can be on 
the Async server

• Queuing - Message queuing must be installed on the Async 
server.
You must create a message queue on the Async machine and 
record its name. The message queue is specified in the 
exe.config file for the service, and the web.config file for the 
Web Service interface.

• CMS - The web.config file includes a key for the location of the 
asynchronous processor. This needs to be verified as working.
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• Other - IIS must be installed on the asynchronous processor. 
IIS allows a Web service call to schedule a file download and 
send commands.
Ektron recommends that the Async machine only allow HTTP 
traffic from Ektron CMS400.NET servers. This provides 
additional security on the Async processor.

Verifying Connections
• You can verify the Web service > queue connection by 

- leaving the Ektron service off, submitting content with 
notifications, and verifying that a message arrived in the 
queue

- turning on journaling for the queue. Submit a message in the 
queue. The Ektron service picks it up and places it in the 
journaled messages.

- turning on logging for the Ektron service

• To verify the CMS > Web service connection, open the 
asynchronous processor location inside a Web browser and 
test the Web services.
To verify the writing of files, ensure that Ektron CMS400.NET 
has write access to the [sitepath]subscriptions directory and 
submit content that will trigger notifications. This action places 
a file inside that directory.

• To verify that the service can download a file, open a Web 
browser on the Async machine and connect to the location of 
the notification command files. Attempt to download one.

Enabling the Web Alert Feature
Enabling the Web Alert feature involves the following steps. This 
section explains each step in detail.

Step Description For more information, see

1. Set up message queue 
and asynchronous pro-
cessor.

”Setting Up the Message Queue 
and Asynchronous Processor” 
on page 164
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2. Create messages. Define components of the email to be 
sent to subscribers.

Ektron CMS400.NET  
Administrator Manual section 
“Web Alerts” > “Creating the 
email Message” 

3. Define subscriptions. Categories of information on your site. 
Site visitors can subscribe to be notified 
when content in a category is added or 
updated.

Ektron CMS400.NET  
Administrator Manual section 
“Web Alerts” > “Defining 
Subscriptions” 

4. Assign Web Alert 
information to folders 
and content.

Assign Web Alert information to folders 
and content items which, when 
published, trigger emails.
For each folder or content item to which 
you assign subscriptions, determine

• activities that trigger emails (for 
example, only upon initial publication 
of content)

• the content of the email

• the subscription list(s) to whom the 
email is sent

Ektron CMS400.NET  
Administrator Manual section 
“Web Alerts” > “Assigning Web 
Alert Information to Folders and 
Content” 

5. Create and publish site 
visitor registration 
page.

Create a new Web form and drop the 
membership server control onto it. Then, 
publish that form on your Web site.

Note: This task is typically done by a 
developer.

Ektron CMS400.NET  
Developer’s Manual > 
“Introduction to Ektron 
CMS400.NET Server Controls 
“> “Membership Server Control”

6. Site visitors subscribe 
to lists of interest.

Someone signs up to be notified when 
changes in a selected subscription 
(category) are published on your Web 
site.

Ektron CMS400.NET  
Administrator Manual section 
“Web Alerts” > “How Users Sign 
up for Subscriptions” 

7. CMS users can also 
subscribe.

Ektron CMS400.NET  
Administrator Manual section 
“Web Alerts” > “CMS User 
Subscription Sign Up”

Step Description For more information, see
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Setting Up the Message Queue and Asynchronous 
Processor

After installing Ektron CMS400.NET version 5.1 or higher, you need 
to set up the Microsoft Message Queuing and the Ektron 
Asynchronous Processor. It is assumed that the following 
directories and files are installed on your server:

• C:\Program Files\Ektron\CMS400v52\EktronAsyncProcessor_Service\

• C:\inetpub\wwwroot\CMS400Example\bin\EktronAsyncProcessorWS.dll

• C:\inetpub\wwwroot\CMS400Example\Workarea\webservices\EktronAsyncP
rocessorWS.asmx

NOTE If you need to move Web services file, use the Asynchronous Processor 
Location field in the Configuration > Setup screen to specify the new folder 
location.

1. On the server that hosts Ektron CMS400.NET, go to Control 
Panel > Add/Remove programs > Add/Remove Windows 
Components.

2. Enable Message Queuing Services.

8. Subscribers are 
automatically notified 
when content is 
updated.

Web content is either first published or 
updated. If at least one subscription is 
assigned to the content or its folder, email 
is sent according to pre-defined criteria 
for the folder.

Step Description For more information, see
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NOTE Note: On Windows 2003, it is within the Application Server Components group.

3. Go to Control Panel > Administrative Tools > Computer 
Management > Services and Applications > Message 
Queuing.

4. Right click the Private Queues folder and add a private queue 
named msmq_web.
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5. Right click msmq_web and select Properties.
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6. Go to the Security tab. You can give the Everyone group Full 
Control if you are in a testing environment. If you are on a 
production server or just want more security, give the local 
system account (the account which the EktronAsyncProcessor 
Service runs as) the following permissions:

•Delete

•Receive Message

•Peek Message

•Send Message

Give the ASP.NET account (the account that the Web services 
interface runs as) Send Message permission.

7. Click OK.
8. Open the following file: 

C:\Program 
Files\Ektron\CMS400v52\EktronAsyncProcessor_Service\RegEktron.S
ervices.EktronAsyncProcessor.bat 

9. Review and update as necessary the paths to the .NET 
directory and Ektron.Services.EktronAsyncProcessor.exe file.

10. Execute the .bat file.
Or, from a command line or Start Menu > Run, enter: 
C:\Windows\Microsoft.NET\Framework\v1.1.4322\installutil 
“C:\program 
Files\Ektron\CMS400v52\EktronAsyncProcessor_Service\Ektron.Serv

ices.EktronAsyncProcessor.exe”

WARNING! Update the paths to the .NET Directory and the .exe file if necessary.

11. Open the following file and enter your SMTP connection 
settings. C:\Program 
Files\Ektron\CMS400v52\EktronAsyncProcessor_Service\Ektron.Serv

ices.EktronAsyncProcessor.exe.config.
12. Go to Control Panel > Administrative Tools > Computer 

Management > Services and Applications. Start the Ektron 
Async Processor Service.
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Asynchronous Log File Reporting
Once the Message Queuing and Asynchronous Process is set up 
and running, you can access a log report about the Asynchronous 
process. This report shows any problems with the Asynchronous 
Processor.

In addition to viewing the report, you can email it to any CMS400 
user. For an explanation of emailing a report, see the User Manual 
section “Content Workflow Reports” > “Common Report Topics” > 
“emailing Reports”.

To access the Asynchronous Process log, follow these steps.

1. In the Workarea’s Smart Desktop, click the Reports folder.
2. Click the Asynchronous Log File link.
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3. If the log has captured any problems, they are displayed on the 
screen.
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Macintosh Editor License

IMPORTANT! For additional information on using the Apple Macintosh as a client, see the User 
Manual section “Macintosh Support for Ektron CMS400.NET Clients”

The Integrated Macintosh Editor License
When using a Macintosh, an additional separate license is needed 
for the Integrated Macintosh Editor (IME). This editor only works 
when using the Safari browser.

The first time you edit content on an Apple Macintosh, the 
Integrated Macintosh Editor is installed. With the installation, there 
is a thirty day trial license. After the trial license expires, you must 
purchase a full license.

The license for the IME is purchased through Ektron. Contact 
Ektron licensing for more information on purchasing a license.

IMPORTANT! If you see the following message, please contact Ektron licensing for a license 
key. Do not contact Ephox -- they cannot provide a license.

mailto: license@ektron.com
mailto: license@ektron.com
mailto: license@ektron.com
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Adding the Integrated Macintosh Editor License to Ektron 
CMS400.NET

When you add the license for the Integrated Macintosh Editor 
(IME), you add it to the Ektron CMS400.NET server where your 
site is hosted. This might be a production or development server 
depending on your business model.

The following steps explain how to add the IME license to Ektron 
CMS400.NET.

1. Copy the editlive.lic file that you were sent when you 
requested a full license.

2. On the Ektron CMS400.NET server, navigate to the following 
location and paste the editlive.lic file.

C:\Inetpub\wwwroot\CMS400Example\Workarea\ewebeditpro\editlivejava

3. Click Yes, when the server asks if you want to overwrite the 
existing file.

Macintosh users should now be able to edit content using the IME 
in the Safari browser.
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Additional Information

Supporting Documents
You can find more detailed information about Ektron CMS400.NET 
in the following documents:

• Ektron CMS400.NET Administrator Manual, Version 5.5 for 
.NET 2.0

• Ektron CMS400.NET Developers Reference Manual, Version 
5.5 for .NET 2.0

• Ektron CMS400.NET User Manual, Version 5.5 for .NET 2.0

Support
If you are experiencing trouble with any aspect of Ektron 
CMS400.NET, please contact the Ektron Support Team via our 
Web Site, or by e-mail:

support@ektron.com

http://www.ektron.com/support/index.aspx

Sales
For questions and answers about purchasing Ektron CMS400.NET 
from Ektron, contact the sales department by sending an e-mail to:

sales@ektron.com

http://www.ektron.com/support/index.aspx
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Ektron, Inc.
5 Northern Boulevard, Suite 6

Amherst, NH 03031 USA
Tel: +1 603.594.0249
Fax: +1 603.594.0258
http://www.ektron.com

http://www.ektron.com
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